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คูมือการใชงานโปรแกรม 
 

 

สวนที่ 1 คูมือการใชงานโปรแกรมระบบสารสนเทศทางภูมิศาสตร (ArcView)  
  
1.1 ความหมายของระบบสารสนเทศภูมิศาสตร  

ระบบสารสนเทศภูมิศาสตร (Geographic Information System: GIS) หมายถึง 
เคร่ืองมือที่ใชระบบคอมพิวเตอร เพ่ือชวยในการนําเขา จัดเก็บ จัดเตรียม ดัดแปลง แกไข 
จัดการ และวิเคราะห พรอมทั้งแสดงผลขอมูลเชิงพ้ืนที่ ตามวัตถุประสงคตาง ๆ ที่กําหนดไว 
ดังน้ัน GIS จึงเปนเคร่ืองมือที่มีประโยชนเพ่ือใชในการจัดการ และบริหารการใช
ทรัพยากรธรรมชาติและส่ิงแวดลอมและสามารถติดตามการเปลี่ยนแปลงขอมูลดานพ้ืนที่ ให
เปนไปอยางมีประสิทธิภาพ เน่ืองจากเปนระบบที่เก่ียวของกับระบบการไหลเวียนของขอมูล 
และการผสมผสานขอมูลจากแหลงตางๆ เชน ขอมูลปฐมภูมิ (Primary Data) หรือขอมูลทุติย
ภูมิ (Secondary Data) เพ่ือใหไดสารสนเทศที่มีคุณคาและสามารถนําไปใชในการบริหาร
จัดการไดอยางมีประสิทธิภาพ  
  
1.2 องคประกอบของระบบสารสนเทศภูมิศาสตร  

ระบบสารสนเทศภูมิศาสตร มีองคประกอบที่สําคัญอยู 5 สวน คือ ขอมูล/สารสนเทศ 
(Data/Information), เคร่ืองคอมพิวเตอรและอุปกรณตาง ๆ (Hardware), โปรแกรม (Software), 
และบุคลากร (User/People), และขั้นตอนการทํางาน (Procedure)  
 

 
  
  

ภาพที่  1 -1  องคประกอบของระบบสารสนเทศภูมิศาสตร (GIS) 
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1.2.1 ขอมูล (Data/Information)   
ขอมูลที่จะนําเขาสู ระบบสารสนเทศภูมิศาสตรควรเปนขอมูลเฉพาะเรื่อง (Theme) 

และเปนขอมูลที่สามารถนําไปใชในการตอบคําถามตางๆ ไดตรงตามวัตถุประสงค เปนขอมูลที่
มีความถูกตองและเชื่อถือได และเปนปจจุบันมากที่สุด โดยขอมูลในระบบสารสนเทศภูมิศาสตร
แบงออกไดเปน 2 ประเภท คือ ขอมูลเชิงพ้ืนที่ (Spatial Data) และขอมูลอธิบาย (non-Spatial 
Data or Attribute Data)  

ขอมูลเชิงพ้ืนที่ (Spatial Data) เปนขอมูลที่แสดงตําแหนงที่ตั้งทางภูมิศาสตร (Geo-
Reference Data) ของรูปลักษณของพื้นที่ (Graphic Feature) ซ่ึงมีอยู 2 แบบ คือ ขอมูลที่
แสดงทิศทาง (Vector Data) และขอมูลที่แสดงเปนตารางกริด (Raster Data) โดยขอมูลที่มี
ทิศทาง ประกอบดวยลักษณะ 3 อยาง คือ  

- ขอมูลจุด (Point) เชน ที่ตั้งหมูบาน โรงเรียน หรือวัดเปนตน  
- ขอมูลเสน (Line) เชน ถนน แมนํ้า เปนตน  
- ขอมูลพ้ืนที่ หรือเสนรอบรูป (Polygon) เชน แหลงนํ้า ผิวดิน เปนตน  

  
 

  

  
ภาพที่  1 - 2  ลักษณะของขอมูลประเภทจุด (Point) 
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ภาพที่  1 - 3 ลักษณะของขอมูลประเภทเสน (Line) 

 
  

 

 
ภาพที่  1 - 4 ลักษณะของขอมูลประเภทพื้นที่ (Polygon) 
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 Column 

  
ภาพที่ 1 - 5 การแสดงขอมูลทั้ง 3 ประเภทรวมกัน 

 
ขอมูลประเภทราสเตอร (Raster Data) จะเปนลักษณะตารางสี่เหลี่ยมเล็กๆ (Grid Cell 

or Pixel) เทากันและตอเน่ืองกัน ซ่ึงสามารถอางอิงคาพิกัดทางภูมิศาสตรได ขนาดของตารางก
ริดหรือความละเอียด (Resolution) ในการเก็บขอมูลจะใหญหรือเล็กขึ้นอยูกับการจัดแบงจํานวน
แถว (Row) และจํานวนคอลัมน (Column) ตัวอยางขอมูลที่จัดเก็บ โดยใชตารางกริด เชน ภาพ
ดาวเทียม หรือขอมูลระดับคาความสูง (Digital Elevation Model: DEM) เปนตน  
  

 
ภาพที่  1 - 6  ลักษณะของขอมูลประเภทราสเตอร (Raster) 

 
 
 
  

 Row 
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ภาพที่  1 - 7  ภาพดาวเทียม (Remote Sensing) เปนขอมูลประเภทราสเตอร (Raster) 

 
 

1.2.2 เครื่องคอมพิวเตอรและอุปกรณตาง ๆ  
เคร่ืองคอมพิวเตอร รวมกันเรียกวา ระบบฮารดแวร (Hardware) จะประกอบดวย 

คอมพิวเตอร อุปกรณการนําเขา เชน Digitizer, Scanner, Global Positioning System (GPS), 
อุปกรณ อานขอมูล เก็บรักษาขอมูล และแสดงผลขอมูล เชน Printer Plotter เปนตน ซ่ึงอุป
กรณแตละชนิดจะมีหนาที่และคุณภาพแตกตางกันออกไป  
 

  

 
ภาพที่  1 - 8  เคร่ืองคอมพิวเตอรและอุปกรณตาง ๆ ของ GIS  

 
1.2.3 โปรแกรมหรือซอฟตแวร (Software)  
Software หมายถึง โปรแกรมที่ใชในการจัดการระบบ และสั่งงานตางๆ เพ่ือใหระบบ

ฮารดแวรทํางาน หรือเรียกใชขอมูล ที่จัดเก็บในระบบฐานขอมูลมาทํางานตามวัตถุประสงค 
โดยท่ัวไปชุดคําสั่งหรือโปรแกรมของระบบสารสนเทศภูมิศาสตร จะประกอบดวย หนวยนําเขา 
ขอมูลหนวยเก็บขอมูลและการจัดการขอมูล หนวยวิเคราะห หนวยแปลงขอมูล หนวยแสดงผล 
และหนวยตอบโตกับผูใช (User Interface)  
  

1.2.4 บุคลากร (Human Resource)  
บุคลากร จะประกอบดวยนักวิเคราะหหรือสรางระบบ (Analyst) และผูใชสารสนเทศ 

(User) โดยผูใชระบบหรือผูชํานาญการ GIS จะตองมีความชํานาญในหนาที่ และไดรับการ     



โครงการฝกอบรม  
โปรแกรม PC Arcview ในการจัดทําฐานขอมูล GIS 
 

 
  

6

ฝกฝนมาแลวเปนอยางดี พรอมที่จะทํางานไดเต็มความสามารถ โดยทั่วไปผูใชระบบจะเปนผู
เลือกระบบฮารดแวรและซอฟตแวร เพ่ือใหตรงตามวัตถุประสงค และสนองตอบความตองการ
ของหนวยงาน สวนผูใชสารสนเทศ (User) คือ นักวางแผน หรือผูมีอํานาจตัดสินใจ (Decision-
maker) เพ่ือนําขอมูลมาใชในการแกไขปญหาตางๆ  
  

1.2.5 ข้ันตอนการดําเนินงาน (Procedure)  
ในระบบสารสนเทศภูมิศาสตร ความถูกตองของขอมูลเปนสิ่งสําคัญที่สุด เพราะการวิ

เคราะหและตัดสินใจจากขอมูลที่ผิดพลาดสามารถจะทําใหเกิดผลเสียอยางใหญหลวง ทั้ง
แรงงาน ความพยายาม และคาใชจายทุกอยางที่ลงทุนไปจะกลายเปนความสูญเปลา ในการ
สรางฐานขอมูลที่ดีจึงตองมีขั้นตอนการทํางานที่ละเอียดถูกตอง เพ่ือใหเปนการประหยัด 
ฐานขอมูลควรไดรับการออกแบบโดยคํานึงถึงเปาหมายใหสามารถใชรวมกันไดในกิจกรรม
หลากหลาย  
  

GIS เปนระบบสารสนเทศที่รวบรวมขอมูลเชิงพ้ืนที่ (Spatial data) และขอมูลอธิบาย
ตางๆ (Attribute data) ดังน้ัน จึงมีประโยชนในการวิเคราะห และตอบคําถามเก่ียวกับความ
สัมพันธดานพ้ืนที่ ไดหลายประการ ซ่ึงสามารถแบงออกไดเปน 5 ประเภท คือ  

1. Location what is at…? มีอะไรอยูที่ไหน  
คําถามแรกที่ GIS สามารถตอบไดคือ มีอะไรอยูที่ไหน หากผูถามรูตําแหนงที่แนนอน 

เชน ทราบชื่อหมูบาน ตําบล หรืออําเภอ แตตองการรูวาที่ตําแหนงนั้นๆ มีรายละเอียดขอมูล
อะไรบาง  

2. Condition where is it?  สิ่งที่อยากทราบอยูที่ไหน  
   คําถามนี้จะตรงกันขามกับคําถามแรก และตองมีการวิเคราะหขอมูล ยกตัวอยาง เชน 
เราตองการทราบวาบริเวณใดมีดินที่เหมาะสมตอการปลูกพืช โดยมีเง่ือนไขวาตองอยูใกลแหลง
นํ้า และไมอยูในเขตปาอนุรักษ เปนตน  

3. Trends what has change since…? ในชวงระยะเวลาที่ผานมามีอะไร
เปลี่ยนแปลงบางคําถามที่สามเปนการวิเคราะหการเปลี่ยนแปลงในชวงระยะเวลาใดเวลาหนึ่ง 
ซ่ึงคําถามน้ีจะเก่ียวของกับคําถามที่หน่ึงและคําถามที่สองวาตองการทราบการเปลี่ยนแปลงของ
อะไร และสิ่งที่ไดเปลี่ยนแปลงอยูที่ไหน มีขนาดเทาไร เปนตน  

4. Patterns what spatial patterns exist?  ความสัมพันธดานพ้ืนที่เปนอยางไร  
   คําถามน้ีคอนขางจะซับซอนกวาคําถามที่ 1 - 3 ตัวอยางของคําถามนี้ เชน เราอยาก
ทราบวาปจจัยอะไร เปนสาเหตุของการเกิดโรคทองรวงของคนที่อาศัยอยูเชิงเขา หรือเชื้อโรค
มาจากแหลงใด การตอบคําถามดังกลาว จําเปนตองแสดงที่ตั้งของมลพิษตางๆ ที่อยูใกลเคียง 
หรืออยูเหนือลําธาร ซ่ึงลักษณะการกระจาย และตําแหนงที่ตั้งของสถานที่ดังกลาว ทําใหเรา
ทราบถึงความสัมพันธของปญหาดังกลาว เปนตน  
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5. Modeling What if …?  จะมีอะไรเกิดขึ้นหาก  
   คําถามนี้จะเ ก่ียวข องกับการคาดการณว า จะมีอะไรเกิดขึ้นหากป จจัยอิสระ 
(Independence factor) ซ่ึงเปนตัวกําหนดการเปลี่ยนแปลงไป ยกตัวอยางเชน จะเกิดอะไรขึ้น
หากมีการตัดถนนเขาไปในพ้ืนที่ปาสมบูรณ การตอบคําถามเหลาน้ีบางครั้งตองการขอมูลอ่ืน
เพ่ิมเติม หรือใชวิธีการทางสถิติในการวิเคราะห เปนตน  
  
ขอจํากัดของระบบ GIS   

GIS เปนเพียงเครื่องมือ (tool) ที่ชวยในการวิเคราะหขอมูลเชิงพ้ืนที่ ที่สามารถทําได 
อยางรวดเร็ว และมีประสิทธิภาพ แตอยางไรก็ตาม GIS ไมสามารถทําอะไรไดทุกอยาง เชน  
  1. GIS ไมสามารถปรับปรุงคุณภาพของขอมูลดิบ (Raw data) ใหมีความถูกตอง หรือ
แมนยําขึ้นได ยกตัวอยางเชน การนําเขาขอมูลจากแผนที่ดิน มาตราสวน 1:100,000 ถึงแมวา 
GIS จะสามารถพิมพแผนที่เปนมาตราสวน 1:50,000 ได แตก็ไมไดหมายความวา ขอมูลน้ันจะ
มีความแมนยํามากขึ้น   
   2. GIS ไมสามารถระบุความผิดพลาดของขอมูลได ยกตัวอยางเชน เจาหนาที่ GIS ได
นําเขาขอมูลชุดดิน แตไดกําหนดรหัสของขอมูลผิดไปจากรหัสในแผนที่ตนฉบับ GIS ไม
สามารถบอกไดวาพ้ืนที่ดังกลาวใหรายละเอียดขอมูลผิด  

3. GIS ไมสามารถเปรียบเทียบคุณภาพขอมูลแตละชั้นขอมูล หรือขอมูลที่มาจากแตละ
แหลงวาขอมูลชุดใด หรือหนวยงานใดผลิตขอมูลที่มีคุณภาพมากนอยกวากัน  

4. GIS ไมสามารถระบุไดวาแบบจําลองในการวิเคราะห หรือเง่ือนไขตางๆ ที่นักวิ
เคราะห GIS หรือผูมีอํานาจตัดสินใจไดเลือกไปน้ัน ถูกตองหรือไม เพระ GIS เปนเพียง
เคร่ืองมือที่นํามาใชในการวิเคราะหขอมูลเทาน้ัน  

5. GIS ไมทราบมาตรฐานหรือรูปแบบแผนที่ที่เปนสากล ยกตัวอยางเชน ขอมูล GIS 
ชุดเดียวกัน แตถาใหนักวิเคราะห GIS จํานวน 2 ทาน มาจัดทําแผนที่จะไดแผนที่ไมเหมือนกัน 
ความสวยงามแตกตางกัน ขึ้นอยูกับประสบการณและความรูของผูผลิตแผนที่เปนหลัก  

6. GIS ไมสามารถทดแทนความรู ความสามารถ ของผูเชี่ยวชาญได ยกตัวอยางเชน 
การวิเคราะหหาพ้ืนที่ที่เหมาะสมตอการใชประโยชนที่ดิน ยังมีความจําเปนที่จะตองมีผู 
เชี่ยวชาญเรื่องดินและการวางแผนการใชที่ดิน เปนผู กําหนดปจจัยหรือเง่ือนไขตางๆ นัก        
วิเคราะห GIS ถึงแมวาจะมีประสบการณในการใชโปรแกรม หรือมีขอมูลเชิงพ้ืนที่และขอมูลอธิ
บายครบถวน ไมสามารถดําเนินการวิเคราะหใหไดผลเปนที่ถูกตองตามหลักวิชาการได เพราะ
ไมไดมีความรูในเรื่องนั้นๆ  
  
1.3 การทํางานของระบบสารสนเทศภูมิศาสตร (GIS Operation System)  
  การทํางานของระบบสารสนเทศภูมิศาสตรประกอบดวย 4 ขั้นตอนหลัก ๆ คือ  
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1.3.1 การวิเคราะหปญหาหรือการกําหนดวัตถุประสงค   
การกําหนดวัตถุประสงค เปนขั้นตอนแรกและสําคัญที่สุดในการดําเนินงานที่

เก่ียวกับระบบสารสนเทศภูมิศาสตร ทั้งน้ีนักวิเคราะห GIS ตองทราบวัตถุประสงคที่ชัดเจนกอน
การดําเนินงานในขั้นตอนตางๆ วาตองการแกไขปญหาอะไร ปญหาดังกลาวสามารถตอบได
โดย GIS หรือไม และผลที่คาดวาจะไดรับจากการวิเคราะหคืออะไร และใครจะเปนผูนําผลการวิ
เคราะหไปใชในขั้นตอนตอไป  

1.3.2 การจัดเตรียมฐานขอมูล  
1) การนําเขาขอมูล (Data Input) สามารถแบงออกไดเปน 2 ประเภท คือ การ

นําเขาขอมูลเชิงพ้ืนที่ (Spatial Data) และขอมูลบรรยายหรือขอมูลทั่วไป การนําเขาขอมูลเชิง
พ้ืนที่เปนการแปลงขอมูลเชิงพื้นที่ใหเปนขอมูลเชิงตัวเลข (Digital Data) ซ่ึงสามารถนําเขาได
หลายวิธี เชน Digitizing Table, คียบอรด (Computer Keyboard) สแกนเนอร (Scanner) นํา
เขาขอมูลแผนฟลม (File Importation) และแปลงคาพิกัดทางภูมิศาสตรที่ไดจากเคร่ือง Global 
Positioning System (GPS) ทั้งน้ีโปรแกรม (Software) ที่ใชในการนําเขามีหลายโปรแกรม เชน 
ArcInfo, ArcView, MapInfo, SPAN, ERDAS เปนตน สวนการนําเขาฐานขอมูลที่มีความ
สัมพันธกับขอมูลเชิงพ้ืนที่สามารถนําเขาโดยโปรแกรม Spreadsheet หรือโปรแกรมทั่วไป เชน 
Excel, Lotus, FoxPro, Word หรือโปรแกรม GIS  

2) การจัดเก็บขอมูลเชิงพ้ืนที่ในระบบสารสนเทศภูมิศาสตร (Cartographic 
Representation) ขอมูลประเภท Vector ซ่ึงประกอบดวยขอมูล 3 ประเภท คือ จุด ลายเสน 
และพื้นที่หรืออาณาบริเวณ ขอมูลดังกลาวจะถูกจัดเก็บโดยอางอิงจากคาพิกัดทางภูมิศาสตร 
ทั้งน้ีรหัสของขอมูลอาจเรียงตามลําดับของการนําเขา หรือเรียงตามคารหัสที่ถูกกําหนดโดยผูใช
ระบบ (User ID) ยกเวนขอมูลกริดที่จัดเก็บตามตําแหนงของแนวตั้ง (Column) และแนวนอน 
(Row)   

3) ความสัมพันธทางพื้นที่ (Spatial Topology) ขอมูลประเภท Vector 
โดยทั่วไปจะมีระบบการจัดเก็บขอมูลเฉพาะของขอมูลแตละลักษณะ (Each Graphic Object) 
ซ่ึงลักษณะความสัมพันธของขอมูลเชิงพ้ืนที่และขอมูลบรรยายในระบบการจัดเก็บแบบนี้เรยีกวา 
ความสัมพันธเชิงพ้ืนที่ (Spatial Topology) โดยการจัดเก็บขอมูลดังกลาวใชเน้ือที่นอย สามารถ
วิเคราะหขอมูลไดรวดเร็ว และหลังจากไดสราง Topology เรียบรอยแลว ขอมูลตางๆ สามารถ
นํามาวิเคราะหเชิงพ้ืนที่ได   

4) การจัดเก็บและการจัดการฐานขอมูล (Database) นิยมใชโครงสรางตาม
หลักการของฐานขอมูลเชิงสัมพันธ (Relational Database) ซ่ึงสามารถใชโปรแกรมระบบ
จัดการฐานขอมูลเชิงสัมพันธ (Relational Database Management System: RDBMS) เพ่ือ
การจัดการฐานขอมูล เชน Microsoft Access, Oracle และ dBase ในการเชื่อมโยงระหวางขอมู
ลกราฟฟกและขอมูลลักษณะสัมพันธได โดยตารางขอมูลที่ใชอธิบายขอมูลเชิงพ้ืนที่หรือที่
เรียกวา Attribute จะถูกจัดเก็บในรูปแบบที่สัมพันธกับขอมูลเชิงพ้ืนที่ เพ่ือใหเปนขอมูลที่มี
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ความถูกตองและงายตอการปรับแกและเรียกใช ขอมูลแตละเร่ืองควรแยกเก็บเปนคนละแฟมข
อมูล (File) และแยกจากขอมูลกราฟฟกหรือขอมูลเชิงพ้ืนที่ แตตองมีรายละเอียดในรายการใด
รายการหนึ่ง (Field) ที่มีคาและคุณลักษณะ (ตัวเลขหรือตัวอักษร) ที่เหมือนกันเพ่ือใชเชื่อมโยง
ตารางขอมูลเขากับขอมูลเชิงพ้ืนที่ หรือเชื่อมโยงตารางขอมูลหน่ึงกับอีกตารางหนึ่ง  
  
การใชระบบฐานขอมูลมีขอดีดังตอไปน้ี  

• ลดความซ้ําซอนของขอมูล การนําขอมูลเรื่องเดียวกันมาจัดเก็บอยางเปนระบบใน
ฐานขอมูลหน่ึงและใหบริการแกผูใชซ่ึงอาจมีไดมากกวา 1 กลุม เปนการประหยัดทรัพยากรและ
มีความสะดวกในการควบคุมคุณภาพของขอมูล  

• เลี่ยงความขัดแยงของขอมูล ในการดําเนินการกับขอมูลไมวาจะเปนการเพ่ิม ลบ หรือ
แกไขขอมูลอาจทําใหเกิดความขัดแยงของขอมูลได เชน กรุงเทพมหานคร กรุงเทพฯ และ 
กทม. ในตารางที่ 1 หมายถึงจังหวัดเดียวกันถึงแมจะพิมพไมเหมือนกัน เม่ือจัดเก็บใน
ฐานขอมูลโดยใชรหัสจังหวัดในการอางอิงดังรูปที่ 10 สามารถหลีกเลี่ยงความขัดแยงของขอมูล
ได  

• สามารถกําหนดสิทธิในการใชขอมูลของผูใชได การเก็บขอมูลไวในฐานขอมูลซ่ึงเปน
ศูนยกลางและจัดการบริการใหกับผูใชหลายกลุม ผูจัดการฐานขอมูลสามารถกําหนดสิทธิในการ
ใชขอมูลใหกับผูใชแตละกลุมไดตามระดับความจําเปนในการใชงาน  

• สามารถควบคุมมาตรฐาน ผูบริหารฐานขอมูลเปนผูควบคุมมาตรฐานดานตางๆ ของข
อมูล การรวมขอมูลไวที่ศูนยกลางทําใหการบริหารมาตรฐานดําเนินการไดสะดวก  

• สามารถควบคุมความปลอดภัยของฐานขอมูล เน่ืองจากผูใชหลายกลุมถูกกําหนดมี
สิทธิในการเขาใชขอมูลแตกตางกันไป การกําหนดระดับของผูใชจึงเปนกลไกสําคัญในการรักษา
ความปลอดภัยของขอมูล  

• สามารถควบคุมความคงสภาพ (Integrity) ของขอมูล ความคงสภาพขอขอมูล 
หมายถึง การท่ีขอมูลมีคุณสมบัติสอดคลองกับความเปนจริง เชน ขอมูลจํานวนนักเรียนตองมี
คาไมนอยกวา 0 เปนตน ในกระบวนการจัดการฐานขอมูลสามารถกําหนดกฎความคงสภาพ
ของขอมูลไดประโยชนของการใชฐานขอมูลจะเดนชัดขึ้นสําหรับระบบใหญๆ ซ่ึงมีผูใชหลายคน 
และขอมูลมีปริมาณมาก ซอฟตแวรระบบสารสนเทศภูมิศาสตรโดยทั่วไปไมไดเปนระบบที่มีผูใช
หลายคน (Multi-user) ดังน้ันการใชฐานขอมูลจึงมีจุดประสงคเพ่ือจัดการขอมูลปริมาณมากๆ 
เทาน้ัน บทบาทของการจัดการฐานขอมูลในระบบสารสนเทศภูมิศาสตรจะเดนชัดขึ้น หากมีการ
ใชเรียกใชขอมูลเชิงพ้ืนที่และทําการวิเคราะหผานระบบเครือขายคอมพิวเตอรซ่ึงปจจุบันมีการ
พัฒนาขึ้นตามลําดับ  

1.3.3 การวิเคราะหขอมูล  
ระบบสารสนเทศภูมิศาสตร (GIS) มีความสามารถในการนําเขาขอมูลเชิงพ้ืนที่หลายๆ 

ชั้นขอมูล (Layer) มาซอนทับกัน (Overlay) เพ่ือทําการวิเคราะหและกําหนดเง่ือนไขตางๆ โดย
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ใชคอมพิวเตอรตามวัตถุประสงค หรือตามแบบจําลอง (Model) ซ่ึงอาจเปนการเรียกคนขอ
มูลอยางงาย หรือซับซอน เชน โมเดลทางสถิติหรือโมเดลทางคณิตศาสตร ทั้งน้ีเน่ืองจากชั้นข
อมูลตางๆ ถูกจัดเก็บโดยอางอิงคาพิกัดทางภูมิศาสตร มีการจัดเก็บอยางมีระบบและ
ประมวลผลโดยใชเคร่ืองคอมพิวเตอร ผลที่ไดรับจากการวิเคราะหจะเปนอีกชั้นขอมูลหน่ึงที่มี
ลักษณะแตกตางไปจากชั้นขอมูลเดิม  

 
การวิเคราะหขอมูลในระบบสารสนเทศภูมิศาสตรมีหลายรูปแบบ ซ่ึงในเอกสารนี้จะบรรยายถึง
การวิเคราะห 4 รูปแบบหลัก ๆ ดังน้ี  
1. พ้ืนที่กันชน  

การสรางแนวพื้นที่รอบส่ิงใดสิ่งหน่ึงเปนระยะทางตามที่กําหนด เรียกวา การสรางพ้ืนที่
กันชน สําหรับขอมูลแบบเวคเตอร สามารถสรางพ้ืนที่กันชนรอบจุด เสน และพ้ืนที่ไดสวนขอมูล
ราสเตอรก็สามารถสรางพ้ืนที่กันชนไดเชนกัน แตดวยลักษณะโครงสรางขอมูลซ่ึงเปนกริดเซลล 
โดยเฉพาะอยางยิ่งถา กริดเซลลมีขนาดใหญ การสรางพ้ืนที่กันชนก็จะยิ่งมีความคลาดเคลื่อน
เชิงระยะทาง ดังน้ันการสรางพ้ืนที่กันชนจึงมักจะใชสําหรับขอมูลแบบเวคเตอร สําหรับขอมูลป
ระเภทหนึ่งๆ สามารถสรางพ้ืนที่กันชนไดหลายชวง (Ring) ตามระยะทางที่กําหนด โดยพื้นที่
กันชน 1 ชั้นและ 2 ชั้นของขอมูลประเภทจุด และพ้ืนที่กันชนของเสนไดแสดงในภาพที่ 9 
ตามลําดับ  
 

 
ภาพที่ 1 - 9  พ้ืนที่กันชนของขอมูลประเภทจุดและเสน 

 
สําหรับพ้ืนที่กันชนของพื้นที่ (Polygon) สามารถสรางไดหลายลักษณะ โดยสรางออก

ไปดานนอกของพื้นที่ และสรางเขามาภายในพื้นที่ทั้งนี้ขึ้นอยูกับวัตถุประสงคของการใชงาน 
เชน การหาพ้ืนที่กันชนของขอมูลประเภทพ้ืนที่ซ่ึงเปนแหลงนํ้าแหงหนึ่ง ในการวิเคราะหหา
แหลงที่อยูอาศัยของกวางที่อยูหางแหลงน้ําไมเกิน 1 กิโลเมตร ดังนั้นในการพิจารณาพื้นที่ที่
กวางอาจอาศัยอยู จะตองสรางพ้ืนที่กันชนออกไปดานนอกของแหลงน้ําเปนระยะ1กิโลเมตร 
และอีกตัวอยางหนึ่ง คือ การหาพ้ืนที่อนุบาลสัตวนํ้าที่อยูหางจากตลิ่งไมเกิน 2 เมตร ดังน้ันตอง
สรางพ้ืนที่กันชนเขามาดานในของแหลงนํ้าเปนระยะ 2 เมตร เปนตน รูปแบบของพื้นที่กันชนที่
สรางออกไปดานนอกและเขามาดานในของขอมูลประเภทพื้นที่ (Polygon) ดังแสดงในภาพที่ 1-
10  
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ภาพที่  1 - 10  รูปแบบการสรางพ้ืนที่กันชนของขอมูลประเภทพื้นที่ (Polygon) 

 
2. การซอนทับขอมูลเชิงพื้นที่  

การซอนทับขอมูลเชิงพ้ืนที่เปนการวิเคราะหขอมูลหลายชั้นขอมูลรวมกัน โดยขอมูล
เหลาน้ันตองอยูในบริเวณเดียวกันและมีคุณลักษณะตางกัน ผลจากการวิเคราะหจะทําใหได
ชั้นขอมูลใหม เชน การวิเคราะหความเสี่ยงตอการสูญพันธุของส่ิงมีชีวิต A โดยช้ันขอมูลที่
นํามาวิเคราะหรวมกันประกอบดวย การกระจายของสิ่งมีชีวิตชนิด X, Y และ Z ซ่ึงมีอิทธิพลต
อสิ่งมีชีวิต A ชั้นขอมูลภูมิประเทศ ชั้นขอมูลการใชประโยชนที่ดิน ชั้นขอมูลการถือครอง
กรรมสิทธิ์ที่ดิน และชั้นขอมูลพ้ืนที่อนุรักษ แผนผังการวิเคราะหขอมูลไดแสดงในภาพที่ 1 - 11  

 
การกระจายของส่ิงมีชีวิต X 
การกระจายของส่ิงมีชีวิต Y 
การกระจายของส่ิงมีชีวิต Z 
ภูมิประเทศ 
การใชประโยชนท่ีดิน 
การถือครองกรรมสิทธิ์ 

                                    ซอนทับขอมูลเชิงพ้ืนท่ี                พ้ืนท่ีเส่ียงตอการสูญพันธุ 
                                                                         ของส่ิงมีชีวิต  

 
ภาพที่  1 - 11  การวิเคราะหขอมูลโดยการซอนทับขอมูลเชิงพ้ืนที ่

 
ในการซอนทับขอมูลมีกระบวนการในการคํานวณโดยใชหลักพีชคณิตบูลีน (Boolean algebra) 
ซ่ึงมีตัวดําเนินการ คือ NOT, AND, OR และ XOR โดยกําหนดใหมีพ้ืนที่ A และ B เม่ือใชตัว
ดําเนินการแบบตางๆ กระทํากับพ้ืนที่ A และ B จะไดผลลัพธดังภาพที่ 1-12  
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ภาพที่  1-12  ผลจากการใชตัวดําเนินการแบบบูลีน (Boolean Algebra)  

 
ซอฟตแวรสวนใหญจะมีตัวดําเนินการเพียง NOT, AND และ OR ถาหากการวิเคราะห

จําเปนตองใช XOR ก็สามารถผสมผสานตัวดําเนินการอ่ืนๆ เขาดวยกันโดย  
  

A XOR B = (A OR B) AND NOT (A AND B) 
  

ในการกําหนดตัวดําเนินการเพ่ือซอนทับขอมูลตองเปนไปตามเง่ือนไขของการวิเคราะห 
เชน ในหนองน้ําแหงหน่ึงกําหนดพ้ืนที่อนุบาลสัตวนํ้าตองอยูหางจากตลิ่งไมเกิน 2 เมตร และต
องมีความลึกไมเกิน 1 เมตร ดังน้ันการหาพื้นที่ที่เหมาะสมตองใชชั้นขอมูล 2 ชั้น โดยชั้นขอมูล
แรกเปนพ้ืนที่กันชนที่สรางเขาไปในหนองนํ้าเปนระยะ 2 เมตร สวนชั้นขอมูลที่สองเปนพ้ืนที่ใน
หนองน้ําที่มีความลึกไมเกิน 1 เมตร ในการวิเคราะหตองนําชั้นขอมูลทั้งสองมาซอนทับกันโดย
ใชตัวดําเนินการแบบ AND เปนตน  
 

3. การวิเคราะหโครงขาย (Network Analysis)   
ในการวิเคราะหโครงขายจะเปนการวิเคราะหขอมูลประเภทเสน (Line) เทาน้ัน โดย

ขอมูลประเภทเสนในระบบสารสนเทศภูมิศาสตรประกอบดวยเสนสมมติ เชน เสนรุง เสนแวง 
และเสนขอบเขตการปกครอง สวนอีกประเภทหนึ่งเปนขอมูลประเภทเสนที่ปรากฏอยูจริง เชน 
เสนถนน เสนแมนํ้า และเสนทางสายไฟฟา ในการวิเคราะหโครงขายจะวิเคราะหเฉพาะขอมูล
เสนที่ปรากฏอยูจริง   

สวนใหญการวิเคราะหโครงขายจะถูกนําไปประยุกตใชกับเสนทางคมนาคม เชน การ
เดินทางจากบานไปที่ทํางานตองใชเสนทางใดจึงจะเปนระยะทางที่สั้นที่สุด ในบางกรณีการหา
ระยะทางที่สั้นที่สุดไมใชคําตอบที่ผูวิเคราะหตองการ แตสิ่งที่ตองการก็คือเสนทางที่ดีที่สุดใน
การเดินทางจากบานไปที่ทํางาน ในการหาคําตอบที่ดีที่สุดขึ้นอยูกับปจจัยที่ผูวิเคราะหตองการ
นํามาพิจารณารวมดวย เชน ระยะทางตองสั้นที่สุด และใชเวลาเดินทางนอยที่สุด และประหยัด
คาใชจายมากที่สุด ดังน้ันการหาเสนทางจากบานไปยังที่ทํางานโดยใชเง่ือนไขระยะทางสั้นที่สุด 
กับเสนทางที่ดีที่สุดอาจไดผลจากการวิเคราะหแตกตางกัน ดังภาพที่ 13  
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ภาพที่  1-13  การวิเคราะหโครงขายหาเสนทางสั้นที่สดุ และเสนทางดีที่สุด 
 
ในการวิเคราะหเสนทางคมนาคมอยางมีประสิทธิภาพจําเปนตองมีฐานขอมูลที่ทันสมัยไมวา
จะเปนเสนทางที่ตัดขึ้นมาใหม และสภาพการจราจร ตลอดจนการนํากฎจราจรเขามารวม
พิจารณาในการวิเคราะห การวิเคราะหในรูปแบบนี้จึงตองมีความละเอียดในการกําหนดปจจัย
เพ่ือใหไดผลการวิเคราะหที่ถูกตองและสามารถนําไปใชไดจริง  
 
4.  การวิเคราะหพ้ืนผิว (Surface Analysis)  

การวิเคราะหพ้ืนผิวเปนการวิเคราะหการกระจายของคาตัวแปรหนึ่งซ่ึงเปรียบเสมือนเป
นมิติที่ 3 ของขอมูลเชิงพ้ืนที่ โดยขอมูลเชิงพ้ืนที่มีคาพิกัดตามแนวแกน X และ Y สวนตัวแปรที่
นํามาวิเคราะหเปนคา Z ที่มีการกระจายตัวครอบคลุมทั้งพ้ืนที่ ตัวอยางของคา Z ไดแก ขอมูลค
วามสูงของพ้ืนที่ ปริมาณน้ําฝน อุณหภูมิ และราคาที่ดิน เปนตน ผลจากการวิเคราะหพ้ืนผิว
สามารถแสดงเปนภาพ 3 มิติใหเห็นถึงความแปรผันของขอมูลดวยลักษณะสูงต่ําของพ้ืนผิวน้ัน 
การแสดงขอมูลพ้ืนผิวสามารถใชโครงสรางขอมูลแบบเวคเตอรโดยการใช Triangulated 
Irregular Network (TIN) หรือใชโครงสรางแบบราสเตอรโดยการใช Digital Elevation Model 
(DEM) 

• TIN แสดงลักษณะของพื้นผิวโดยการใชรูปสามเหลี่ยมหลายรูปซ่ึงมีดานประชิดกัน
และใชจุดยอดรวมกันเรียงตอเน่ืองกันไป โดยคา Z จัดเก็บอยูที่จุดยอดของสามเหลี่ยม จุดเหล
าน้ีจะกระจายตัวไมสมํ่าเสมอ โดยพ้ืนที่ที่มีความแตกตางของคา Z มากๆ จุดจะอยูใกลๆ กัน 
แตพ้ืนที่ที่มีคา Z ไมแตกตางกันนัก จุดจะอยูหางกันดังที่แสดงในภาพที่ 14 ดานซายมือ  

• DEM มีลักษณะเปนกริดเซลลขนาดเทากันเรียงตอเน่ืองกันครอบคลุมทั้งพ้ืนที่ คา
ประจํากริดเซลลคือคา Z ดังน้ันคา Z ในพ้ืนที่จึงมีการกระจายตัวอยางสมํ่าเสมอ ดังภาพที่ 1-14   
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ภาพที่  1-14  ลักษณะของ TIN และ DEM 

 
ในเบื้องตนขอมูลคา Z ที่ใชในการวิเคราะหพ้ืนผิวมีอยูเพียงบางจุดในพื้นที่ศึกษา เชน 

ขอมูลนํ้าฝนมีอยูที่ตําแหนงของสถานีนํ้าฝนซึ่งกระจายอยูในพ้ืนที่ศึกษาเทาน้ัน การจะวิเคราะห
คา Z จึงจําเปนตองใชการประมาณคาเชิงพ้ืนที่ (Spatial Interpolation) ภายใตสมมติฐาน 2 ข
อคือ คา Z ตองมีการเปลี่ยนแปลงแบบตอเน่ืองคอยเปนคอยไป และคา Z ตองมีความสัมพันธ
เชิงพ้ืนที่ โดยคา Z ของจุดที่ไมทราบคาจะมีคาใกลเคียงกับจุดที่ทราบคาที่อยูไกลออกไปเปนระ
ยะทางนอยที่สุด  

การวิเคราะหพ้ืนผิวสามารถนําไปประยุกตใชไดหลายแนวทาง ไมวาจะเปนการวิ
เคราะหภาพตัดขวาง การแสดงลักษณะของพ้ืนผิว การวิเคราะหความสามารถในการมองเห็น 
ภูมิประเทศจากมุมมองตางๆ การคํานวณปริมาตรของพื้นที่ และการแสดงลักษณะภูมิประเทศร
วมกับแผนที่ หรือภาพถาย เชน ภาพดาวเทียม Landsat ดังแสดงในภาพที่ 1-15  
 

 

 
ภาพที่  1-15  การแสดงขอมูลจากภาพดาวเทียมรวมกับ DEM  

 
 

1.3.4 การแสดงผลขอมูล  
ผลที่ไดรับจากการวิเคราะหขอมูล สามารถนําเสนอหรือแสดงผลไดทั้งบนจอ

คอมพิวเตอร (Monitor) ผลิตออกเปนเอกสาร (แผนที่และตาราง) โดยใชเคร่ืองพิมพ หรือ 
Plotter หรือสามารถแปลงขอมูลเหลาน้ันไปสูระบบการทํางานในโปรแกรมอื่นๆ ในรูปแบบของ
แผนที่ (Map) แผนภูมิ (Chart) หรือตาราง (Table) ได  
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ภาพที่  1-16  การแสดงผลขอมูลของระบบสารสนเทศภูมิศาสตรในลักษณะของแผนที่ (Map) 
 
1.4 เร่ิมตนกับโปรแกรม ArcView 3.3 
  

การเขาสูโปรแกรม สามารถกระทําไดโดยการ Double-Click บน ArcView Icon (ใน
กรณีที่มี icon) หรือ ผานทาง Start > Program File > ESRI > ArcView  เม่ือเขาสูโปรแกรม 
ArcView จะประกอบไปดวยหนาตางที่สําคัญ 6 หนาตาง คือ Project Window, View Window, 
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Table Window, Chart Window, Layout Window และ Scripts Window  
 

 
ภาพที่  1-17  หนาตางภายในโปรแกรม ArcView 

  
สวนประกอบหลัก ๆ ของหนาตาง ArcView จะประกอบไปดวย  
• หนาตาง (Windows) ซ่ึงประกอบดวย 6 หนาตาง คือ Project Window, View 

Window, Table Window, Chart Window, Layout Window และ Scripts Window  
• เมนู (Pull down Menus) จะเปลี่ยนแปลงไปตามการทํางานของหนาตางทั้ง 6 ชนิด  
• แถบเครื่องมือ (Toolbars) จะเปลี่ยนแปลงไปตามการทํางานของหนาตางทั้ง 6 ชนิด  
• ไอคอน (Icon) ซ่ึงอยูภายใต Project Window ประกอบไปดวย View icon, Table 

icon, Chart icon, Layout icon และ Scripts icon  
 

1.4.1 กลองขอความหนาจอเริ่มตน (Startup Screen Dialog)  
เม่ือเปดโปรแกรมแลวหนาจอจะปรากฏกลองขอความถามถึงการจัดการ Projectใน

กรณีที่สราง Project ใหม ใหเลือก  
• With a new View จะเรียก View windowใหดวย   
• As a blank project จะไมเรียก View window ให  
• Open an existing project เรียกขอมูลเกาที่เก็บไว   
• Show this window when ArcView GIS Starts เปนการเลือกใหแสดง Dialog น้ี

หรือไมเม่ือเปดโปรแกรม ArcView ขึ้นมา ถาตองการใหมีเคร่ืองหมายถูกไวขางหนา  
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ภาพที่  1-18  กลองขอความหนาจอเริ่มตน 

  
1.4.2 การจัดการ Project  

1) การสรางแฟมฐานขอมูลที่ทํางาน (New Project) ในการสราง Project 
ใหม สามารถทําไดโดยเลือกเมนู File --> New Project บนเมนูบาร เชนเดียวกับการเปดขอมูล
ที่มีอยูแลว  

2) การเปดแฟมฐานขอมูลที่มีอยูแลว (Existed Project) ในการเปดแฟมขอ
มูล Project ที่เคยทํางานไวอยูแลวทําไดโดยเลือกที่เมนู File Open Project…แลวเลือกแฟม 
Project ที่ตองการใชงานได  

3) การบันทึกแฟมฐานขอมูลที่ทํางาน (Save Project) เปนการบันทึกแบบ
โครงการที่ทํางานเก็บไวในฐานขอมูล เพ่ือใหสามารถเรียกใชไดในคร้ังตอไป ในการทํางาน
อาจจะบันทึกกอนหรือหลังการทํางานก็ไดทําไดโดยเลือก Project Windows ให Active กอน 

เพ่ือเปนการเปลี่ยน เมนูที่ตองการใชงาน กดปุม   หรือ เลือกเมนู File > Save Project 
as… เลือก Directory ที่ตองการ พรอมตั้งชื่อแฟมขอมูล แลวกดปุม OK ถือวาเสร็จสิ้นการ
บันทึก  
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ภาพที่  1-19  การจัดการ Project 

  
1.4.3 การเตรียมหนาตางแสดงผลขอมูลแผนที่ (View Window)  

การแสดงแผนที่ Graphic บนโปรแกรมระบบสารสนเทศภูมิศาสตร หรือการ
นําขอมูลเชิงพ้ืนที่ที่เรียกกันวา Spatial Data หรือ Graphic data มาแสดงผลบนโปรแกรม ทํา
ไดโดย ใหเปด View Window ใหมขึ้นมา โดย double-click ที่ icon View หรือสามารถเลือกที่

icon view   แลวกดปุม New บน Project window ก็ได เราสามารถเปดไดมากกวา 1 
View ใน 1 Project และเปลี่ยนชื่อหรือคุณสมบัติของ View ได  
 

  1.4.4 การกําหนดระบบหนวยพิกัดที่เหมาะสม  
เราจะตองคํานึงถึงขอมูลที่เรานําเขามาในระบบ GIS วาระบบวัดพิกัดเปนแบบใด

ระหวาง grid coordinate หนวยเปนเมตร หรือ geographic coordinate หนวยเปนองศา ลิปดา 
ฟลิปดา ซ่ึงใหกําหนดดังน้ี   

1)  ใหเลือก View Window ที่ตองการให Active   
2)  เลือกเมนู View--> Properties เพ่ือทําการปรับแตคุณสมบัติหนาตางแสดงผล   
3)  แลวกําหนดคาตาง ๆ ใน View Properties Dialog Box ดังน้ี   

3.1)  Name: ใหตั้งชื่อแผนที่ที่ตองการแสดง  
3.2)  Creation Date: วันที่ทําปฏิบัติการ   
3.3)  Creator: ผูทําปฏิบัติการ   
3.4)  Map Units: โดยสวนใหญเปนระบบ grid coordinate เรากําหนดเปน 

Meters หรือถาเปน geographic coordinate ใหกําหนดเปน decimal degree  
3.5)  Distance Units: โดยสวนใหญเรากําหนดเปน Meters เพ่ือวัดระยะทาง

ใน view window  
   4)  แลวกดปุม OK เปนการเสร็จขั้นตอนเตรียมหนาตางแผนที่   
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ภาพที่  1-20  การกําหนดระบบหนวยพิกัดที่เหมาะสม 

  
1.4.5 การเพิ่มขอมูลแผนที่ และการแสดงแผนที่   

1) Add Theme โดยกดที่ปุม   (Add Theme Toolbar) เรียกขอมูล ดังตอไปน้ี   
** ขอมูลชนิดจุด (Point Feature)  
** ขอมูลชนิดเสน (Line Feature) ชื่อ  
** ขอมูลชนิดรูปหลายเหลี่ยมปด (Polygon Feature)   

วิธีการเลือกขอมูลพรอมกันหลาย Coverage หรือหลาย Theme ใหกดปุม Shift คางไว
ขณะที่เลื่อนเมาสไปเลือก Coverage อ่ืน ๆ เพ่ิม  
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ภาพที่  1-21  การเพ่ิมขอมูลแผนที่และการแสดงแผนที่ 
  

เม่ือ Add Theme เขามาแลวมักจะเกิดการแสดงผลที่ทับขอมูลกัน เชน ขอมูลประเภท 
Polygon บังสวนที่อยูดานลาง ทําใหไมสามารถเห็นขอมูลอ่ืน ๆ ใหกด Drag เมาสเลือก Theme 
บน แลว Drop ที่ลางสุด ดังภาพที่แสดงขางลาง ซ่ึงโดยปกติการแสดงผลเพ่ือไมใหเกิดการซอน
บังขึ้น ควรเรียงลําดับจากขอมูลประเภท จุด เสน และรูปหลายเหลี่ยม ตามลําดับ  
  

 
ภาพที่  1-22  การแสดงผลขอมูลทีว่างซอนกันเปนชั้น (Layer) 

  
1.4.6 การยอขยายหนาตาง (Zoom in - Out Window)   
การแสดงแผนที่ในขนาดตาง ๆ ในการทํางานบน ArcView บน View Window น้ันจะต

องเลือก Theme ที่ตองการทํางานให Active กอนเสมอ (Them ที่ถูกเลือกจะนูนขึ้นมาเห็นได
ชัดเจน) เชน ถาตองการแสดงผลยอ-ขยายหนาตาง แสดงผล ตองเลือก Theme ที่ตองการกอน
โดยดําเนินการ ดังน้ี   

** ตองการแสดงผลหนาจอทั้งหมดกดปุม   (Zoom to Full Extent button) ภาพ
บนหนาตางก็จะ zoom เทากับ ขนาดของแผนที่ที่ใหญที่สุดใน Project  

** ตองการแสดงผลหนาจอเล็กลงเทากับ ขอบเขตการปกครองระดับอําเภอ (Amphur) 

ใหเลือกที่ Theme ชื่อ Amphur แลวกดปุม   (Zoom to Active Theme(s) 
** ถาตองการ Zoom ทั้งหนาตาง โดยก่ึงกลางของจอ view window จะเปนจุดศูนย

กลางของการขยายยอภาพ ใชปุมขยาย   (Zoom In) และยอ   (Zoom Out) แลวจึงค

อยเลื่อนภาพดวยปุม   (Pan) เพ่ือเลื่อนไปยังบริเวณที่ตองการดูน่ันเอง  
** ถาตองการ Zoom ยอหรือขยาย โดยกําหนดบริเวณขอบเขตที่กําหนด หรือตองการ

เปนสี่เหลี่ยมใหใชปุม   เพ่ือขยายขนาดภาพ และ   เพ่ือยอขนาดภาพ  
  

1.4.7 การกําหนดพื้นที่ในการทํางาน (Working directory)  
พ้ืนที่ในการทํางานของเรา คือตําแหนงหรือ Directory ที่จะใชในการเก็บขอมูล

ของ project น้ัน เราสามารถกําหนดขึ้นได โดย File > Set Working Directory จากน้ันพิมพ 
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directory ที่จะใชเปนพ้ืนที่ในการทํางาน  
  

 
ภาพที่  1-23  การกําหนดพ้ืนที่ในการทาํงาน 

  
เราควรจะกําหนดพ้ืนที่ในการทํางานใหกับ Project ทุกคร้ังเพ่ือความสะดวกใน

การทํางาน เน่ืองจากเม่ือเรากําหนดพ้ืนที่ในการทํางานแลว โปรแกรมจะถือวา directory น้ันเป
น directory เริ่มตนในการเพิ่ม ลบ หรือการสรางขอมูลใหม  
  

1.4.8 การปรับแตง Theme   
หลังจากที่ไดเพ่ิมขอมูล (Add Theme) เขาไปบนView ภาพที่ปรากฏบนจอ

จะเปนสีเดียว หรือชั้นอันตรภาคเดียว (single symbol) การแกไขสัญลักษณของ Theme แตละ
ประเภทจะแตกตางกัน ใหสังเกตดูวาเปน Theme ชนิดใด point, line หรือ polygon เพ่ือจะได
เขาใจปรับแกไดอยางงายดาย และเลือกชนิดของสัญลักษณใหเหมาะสมกับแผนที่ หรือชนิดของ 
Theme การปรับแตง Legend ของแตละ Theme น้ันขึ้นกับ Attribute Table ของ Theme ดัง
กลาววามีรายละเอียดในแตละ field เปนอยางไรบาง หรือมีขอมูลที่เราตองการใชแสดงผลหรือ
ไมอยางไร หากมีที่ตองการก็สามารถปรับแตงไดตามขั้นตอน แตถาไมมีจะตองนํา Attribute 
table เขามาสรางความสัมพันธ relation ระหวางตาราง Legend Editor ในโปรแกรม ArcView 
สามารถแกไขสัญลักษณของขอมูลทั้งที่เปนจุด (Point) เสน (Line) และพ้ืนที่ (Polygon) โดย

การ Click ที่เคร่ืองหมาย   (Edit Legend button) หรือ Double-Click ที่ Active Theme 
บน View window (เปนพ้ืนนูนขึ้นมา) แลวเลือก Legend Type  ดังรูป  
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ภาพที่  1-24  การปรับแตงสัญลักษณของ Theme ในการทํางาน 

  
Legend Type มี 5 ประเภท คือ   

1)  Single symbol คือ ใชสัญลักษณเดียวแสดงทุกคาของขอมูล ใชไดกับขอมู
ลแบบจุด เสน และพ้ืนที่  

2)  Graduate Color คือ ใชความเขมของสี กับชั้นอันตรภาคขอมูลที่ไดแบงไว ใช
ไดกับขอมูลแบบ จุด เสน และพ้ืนที่  

3)  Graduate Symbol คือ ใชขนาดของสัญลักษณกับชั้นอันตรภาคขอมูลที่ไดแบ
งไว ใชไดกับเฉพาะขอมูลแบบจุด และเสน เทาน้ัน  

4)  Unique Value คือ ใชสัญลักษณหน่ึงแทนหนึ่งคาของขอมูล ใชไดกับขอมู
ลแบบจุด เสน และพ้ืนที่  

5)  Dot คือ ใชจํานวนจุดเปนสัญลักษณแทนคาขอมูล ใชไดเฉพาะขอมูลแบบพ้ืนที่
เทาน้ัน  

6)  Chart คือ ใชแผนภูมิเปนสัญลักษณแทนคาขอมูล ใชไดกับขอมูลแบบจุด เสน 
และพ้ืนที่  
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ภาพที่  1-25  การกําหนดประเภทของสญัลักษณที่แสดงผลขอมูล 

  
1.4.9 การปรับแกใหเปนภาษาไทยในสวนของ Table of Content  

เม่ือทําการเปลี่ยนชื่อ Theme ในสวนของคุณสมบัติใหเปนชื่อภาษาไทยแลว 
แตจะพบวาขอมูลใน Table of Content (TOC) จะไมสามารถอานภาษาไทยได เราสามารถ
ปรับแกใหอานภาษาไทยไดดังน้ี   

1.  ใหเลือกเมนู View > TOC Style  
2.  แลวปรับแตคาใหเปน Font ภาษาไทย เชน AngsanaUPC และขนาด

ตัวอักษร  
   3.  แลวกดปุม Apply และ Close ตามลําดับ  
  

 
ภาพที่  1-26  การปรับแกภาษาที่แสดงในสวนของ Table of Content 

  
1.4.10 การคัดลอก ยาย และลบ Theme  
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จากเมนู Edit --> แลวในรายละเอียดจะมีใหเลือก คือ  
** Cut Themes ถาหากเรามีความตองการที่จะยาย Themes ไปยัง view อ่ืน ๆ ได  
** Copy Themes ถาหากเรามีความตองการที่จะคัดลอก Themes ไปยัง view อ่ืนๆ 

ได  
** Delete Themes ถาหากเรามีความตองการที่จะลบ Themes ออกจาก view ได  

เม่ือไดทําการ Cut หรือ Copy แลว ใหทําการวางไวยัง view ที่ตองการโดยคําสั่ง Edit --> 
Paste  
  

 
ภาพที่  1-27  การคัดลอก ยาย และลบชัน้ของขอมูล 

  
1.4.11 การใสคําอธิบายแผนที่ (Text Label)  

1.  เลือก theme ที่ตองการใสขอความให active   
2.  เลือกเมนู theme--> properties  
3.  Click เลือกที่ Text Label icon แลวเลือกรายละเอียดใน Label Field ที่ตอง

การใสขอความ และสามารถเลือกตําแหนงของขอความ ตามเหมาะสม   
4.  ใสรายละเอียดของขอความ ซ่ึงมี 2 วิธี  

4.1)  ใสทีละจุดที่ตองการ ใหกดที่ปุม   (label) แลวไปกดที่ตําแหนง
ที่ตองการ  

4.2)  ใสทั้งพ้ืนที่ทุกจุด หรือทุกเสน ใหเลือกเมนู Theme -->Auto Label  
 
 
 
การใสคําอธิบายและขอความเพิ่มเติมเปนภาษาไทย (Thai Label)  
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การใสขอความอธิบาย (Label) ในครั้งแรกอาจเปนตัวหนังสือที่อานไมได หรือ
ไมเปนที่ตองการ เราสามารถที่จะเปลี่ยนแปลงได โดยมีวิธีการดังตอไปน้ี  

1)  เลือกไปยังตัวอักษร (label) ที่ไมสามารถอานภาษาไทยได หรือที่ตองการ
เปลี่ยนรูปแบบตัวอักษร (font)  

2)  เลือกเมนู Window -->Show Symbol Windows หรือ กด Ctrl + P  
3)  เลือกแถบ (font Palette)  

4) กดปุม   Pointer เพ่ือไปใชในการ click เลือก Text หรือ Label ที่อาน
ไมได   

5) แลวทําการเปลี่ยนเลือกเปน AngsanaUPC หรือ รูปแบบตัวอักษร
ภาษาไทย และสามารถเปลี่ยนขนาด ประเภท และสีไดตามตองการ  
 

 

ภาพที่  1-28  การใสคําอธบิายและขอความเพิ่มเติมเปนภาษาไทย 

 
1.4.12 การนําเขาขอมูลประเภทอ่ืน ๆ  

เราสามารถนําเขาขอมูล จากแหลงขอมูลประเภทตาง ๆ ไดหลาย ๆ รูปแบบ           
ไมวาจะเปน ขอมูล Vector representation จากแหลงตอไปน้ี Coverage ของ PC Arc/Info 
หรือ Shape file ของ PC ArcView หรือ DXF ของ AutoCAD เปนตน  

นอกจากนี้เรายังสามารถนําเขาขอมูล Raster representation เขามาใน PC 
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ArcView ได เชน ขอมูล Remote Sensing Imagery จากโปรแกรมตางๆ เชน ERDAS 
Imagine, PCI/EasyPace, ENVI ทุกรูปแบบ อาจจะสงออกจากโปรแกรมเฉพาะเหลาน้ันมาอยู
ในรูปแบบ format มาตรฐานคือ BIL (Band Interleave by Lines) จะทําใหสามารถอานไดงายด
วยโปรแกรม PC ArcView  

ในการเรียกอานขอมูลไมวาจะเปน Vector ประเภทใด ๆ ไดก็ตามใหเรา
ทดลองดูวาเราสามารถเปดขอมูลอานไดหรือไม โดยกําหนดรูปแบบของแหลงขอมูล เปนแบบ 
Feature Data Source โดยหลังจากที่ทานเปดโปรแกรม PC ArcView แลว ใหเปด Project 
เปลาใหมขึ้นมา จากน้ันใหเพ่ิม View window เปลาขึ้นมาใหม  
 

 
  

ใหเลือกเมนู View --> Add Theme หรือกดปุม Ctrl + T เพ่ือเพ่ิมคําสั่ง 
Theme ใหมๆ แลวใหเปลี่ยน Directory ไปที่ C:\esri\av_gis30\avtutor\arcview ซ่ึงเปน 
directory ตัวอยางจากโปรแกรม PC ArcView ที่ติดมาตอนติดตั้งโปรแกรมแลว  

ในการเรียกใชงานขอมูล Vector Data เราตองเปลี่ยน Data Source Types: 
ใหเปน Feature Data Source ใหลองเปลี่ยน Directory ไปที่ CAD ซ่ึงเก็บรูปภาพ CAD หรือที่ 
C:\esri\av_gis30\avtutor\arcview\cad พบวายังไมสามารถมองเห็นขอมูล CAD ได เราจะตอง
ทําการเปลี่ยนแปลงโดย Cancel ออกไป เพ่ือเรียก Extension สําหรับการอานขอมูลเฉพาะ 
ดังน้ี เลือกที่เมนู File --> Extensions... แลวเลือกในสวนของคําสั่งที่ตองการเพ่ิมเติม เชนให
อาน AutoCAD DXF ได ตองเลือก Extentions ที่ชื่อวา Cad Reader ดังภาพ แลวกดปุม OK   
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จากน้ันใหทําการเพ่ิม Theme เขามาใหม โดยเลือกที่ Theme ชื่อ Parcels.dwg โดยให

กดที่ icon ดานหนา จะไดรายละเอียดของ feature ที่จะนําเขามา ใหเลือกทุกประเภท จะไดดัง
ภาพ  
  

 
 
  
เม่ือเพ่ิมขอมูลเขามาก็จะไดขอมูลทีต่องการใน View window ให Zoom in เขาไปดูรายละเอียด 
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ในการเรียกอานขอมูลไมวาจะเปน Raster ประเภทใด ๆ ไดก็ตามใหเราทดลองดูวาเรา
สามารถเปดขอมูลอานไดหรือไม โดยกําหนดรูปแบบของแหลงขอมูล เปนแบบ Image Data 
Source ซ่ึงโดยปกติโปรแกรม PC ArcView จะสามารถอานขอมูลที่มี format เปน BIL ไดอยู
แลว หากตองการขอมูลประเภทอ่ืน ๆ ก็ตองเขาไปกําหนดเลือกใน Extensions ตอไป ซ่ึงมีอีก
หลายรูปแบบที่สามารถนําเขามาได เชน BMP, BSQ, BIL and BIP, Image catalogs, GRID, 
Sun raster files, TIFF, TIFF/LZW compressed, Compressed ARC Digitized Raster 
Graphics (CADRG) (if ArcView's CADRG Image Support extension is loaded), 
Controlled Image Base (CIB) (if ArcView's CIB Image Support extension is loaded), 
ARC Digitized Raster Graphics (ADRG) (if ArcView's ADRG Image Support extension is 
loaded), ERDAS IMAGINE (if ArcView’s IMAGINE image extension is loaded), IMPELL 
Bitmaps (Run-length compressed files), JPEG (if ArcView’s JPEG image extension is 
loaded), MrSID (if ArcView’s MrSID image extension is loaded), National Image 
Transfer Format (NITF) (if ArcView's NITF Image Support extension is loaded)   

ในการ Load extension หมายถึง เราจะตองไปเปดใชงาน Extension น่ันกอนในเมนู 
File --> Extensions... ดังตัวอยางมีให Load หลาย format  
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ภาพที่  1-29  การเลือกฟงกชันเสริม (Extension) ในการใชงานโปรแกรม 

  
ใหเตรียม View window ใหม แลวใหลองดึงฐานขอมูลเขามา โดยเปลี่ยนไปที่ 

C:\esri\av_gis30\avtutor\arcview\images ซ่ึงเก็บตัวอยางฐานขอมูลรูปแบบตาง ๆ ไวใหทด
ลองใชงาน  
  

 
  

ใหเปด Theme แลวให Active ไว จากน้ันให Zoom to Active Theme เน่ืองจากขอมูล 
Remote Sensing เหลาน้ีมีพิกัดภูมิศาสตรที่ตางพ้ืนที่กัน เลยจะแสดงผลที่ตางพ้ืนที่กันตองดูที
ละสวนถึงจะเห็นรายละเอียดที่ชัดเจน   
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วิธีการเหลาน้ีพอเปนแนวทางในการนําขอมูลเขามาใชในการแสดงผลบน View 
window ซ่ึงทานสามารถศึกษาและหาเอกสารอ่ืน ๆ อานเพ่ิมเติมเพ่ือเพ่ิมพูนความรูตอไปไดใน
อนาคต  
  

1.4.13 การเพิ่มความสามารถของโปรแกรมดวย Extension  
ในการเพิ่ม Extension ในโปรแกรม ArcView สามารถกระทําไดดังน้ี  
1) Copy File Extension น้ัน ๆ (ชื่อ Extension.avx) ไปไวที่

C:\ESRI\AV_GIS30\ARCVIEW\ EXT32 ดังรูป เปนอันเสร็จเรียบรอย  
  

 
  

1.4.14 การสรางชั้นขอมูลเชิงพื้นที่ ใหม (Create new theme)  
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การสรางขอมูลเชิงพ้ืนที่ขึ้นใหมทําไดโดยเลือกที่เมนู View > New Theme บน 
Menu Bar จะปรากฏ Dialog Box ขึ้นมาเพื่อใหทําการเลือกรูปแบบขอมูลเชิงพ้ืนที่ลักษณะตาง 
ๆ เลือกลักษณะรูปแบบขอมูลที่ตองการสราง แลวกดปุม OK   
  

  
         

ภาพที่  1-30  แสดงขั้นตอนการสรางขอมูลเชิงพ้ืนที ่
  

จากน้ัน Dialog Box สําหรับการบันทึกขอมูลจะปรากฏขึ้น ใหเลือก directory 
ที่ตองการจัดเก็บ และตั้งชื่อขอมูล ทําการบันทึกโดยกดปุม OK ดังรูป  
  

 

 
  

ภาพที่  1-31  แสดงการบันทึกขอมูลเชิงพ้ืนที่ 
 
 

1.4.15 การสรางขอมูลเชิงพื้นที่ลักษณะจุด (Create Point Theme)  
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• ขอมูลเชิงพ้ืนที่แบบจุดสรางโดยเลือกเคร่ืองมือ (Draw Point) ที่ Tools Bar จากน้ัน
เลือกตําแหนงที่ตองการใน View Window แลว Click mouse เพ่ือสรางขอมูล Point Features 
ลงบนตําแหนงที่ตองการ ดังรูป  

 

 

 
ภาพที่  1-32  แสดงการสรางขอมูลเชิงพ้ืนที่ลักษณะจดุ 

  
• ขอมูลจากคาพิกัดทางภูมิศาสตรซ่ึงอาจไดมาจากการอานคาจาก GPS หรืออานจาก

แผนท่ีสามารถทําเปนขอมูลในแบบระบบสารสนเทศภูมิศาสตรไดโดย สรางแฟมขอมูลที่
ประกอบไปดวยคา X - Y Coordinates ใหอยูในรูปแบบของ dBASE (*.dbf) หรือ Text (*.txt)   
อยางใดก็ไดดังรูป  
  
 

 

 

  
  
 
 

 

 

 

ภาพที่  1-33  แสดงการเตรียมขอมูลสําหรับนําเขาสูระบบขอมูลสารสนเทศภูมิศาสตร 
ตอมาจึง Add Table ที่สรางขึ้นเขามาใน Project โดยเลือกที่ Project Window > 

Table > Add แลวเลือก File ขอมูลจากคาพิกัดทางภูมิศาสตรที่ตองการ และเลือก OK ดังรูป  
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ภาพที่  1 - 34  แสดงการนําเขาขอมูลพิกัดสูโปรแกรม ArcView 
  

จากน้ันให Active ที่ View Window แลวเลือกที่ View > Add Event Theme… ที่ 
Menu Bar จากน้ันจะปรากฏหนาจอใหเลือก Table และ Field ใหเลือกใหถูกตอง และเลือก OK 
ดังรูป  
  

 
  

ภาพที่  1-35  แสดงขั้นตอนการสรางขอมูลเชิงพ้ืนที่แบบจุดจากขอมูลพิกัดภูมิศาสตร 
 
 
 

โดยขอมูลจากคาพิกัดทางภูมิศาสตรที่นําเขาก็จะไปปรากฏใน View Window ดังภาพ 
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ภาพที่  1-36  แสดงขอมูลเชิงพ้ืนที่แบบจุดที่ไดจากขอมูลพิกัดภูมิศาสตร 
  

หากตองการนําขอมูลจากคาพิกัดทางภูมิศาสตรไปเปน Shapefile สามารถทําไดโดย 
Active Theme ที่ตองการ แลวเลือกที่ Theme > Convert to Shapefile ที่ Menu Bar จะมี 
Dialog Box ใหเลือก Directories และตั้งชื่อ File แลวเลือก OK ดังรูป  
  

 
 
 

 
  

ภาพที่  1- 37  แสดงการแปลงขอมูลเปนแบบ Shape file 
  
 

 

 

 

 

สุดทายมี Message Box ถามวาจะเพ่ิม Shapefile เปน Theme เขาไปใน View 
Window หรือไม เลือก Yes ถาตองการ เลือก No ถาไมตองการ  
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ภาพที่ 1-38 แสดงถึงการแปลงขอมูลเสรจ็สมบูรณและสามารถทําการเปดขอมูลดูไดถาตองการ 
  

1.4.16 การสรางขอมูลเชิงพื้นที่ลักษณะเสน (Create Line Theme)  
ขอมูลเชิงพ้ืนที่แบบเสนสรางโดยเลือกเคร่ืองมือ   (Draw Line) ที่ Tools 

Bar จากน้ันเลือกตําแหนงที่ตองการใน View Window แลว Click mouse เพ่ือเปนการเร่ิมจุด
เริ่มตน จากนั้น Click mouse ตอไปเพ่ือสรางแนวหรือเสนทางของขอมูลเชิงพ้ืนที่แบบเสน 
จนถึงจุดส้ินสุดของขอมูล ให Double Click เพ่ือเปนการสิ้นสุด ดังรูป  

 
 

 
 

ภาพที่  1-39  แสดงการสรางขอมูลเชิงพ้ืนที่ลักษณะเสน 
  1.4.17 การสรางขอมูลเชิงพื้นที่ลักษณะพื้นที่ (Create Polygon Theme)   

การขอมูลเชิงพ้ืนที่แบบพ้ืนที่โดยโปรแกรม ArcView แบงไดตามลักษณะเครื่องมือได 2 
แบบ คือ ขอมูลเชิงพ้ืนที่รูปทรงเรขาคณิต และขอมูลเชิงพ้ืนที่รูปทรงอิสระ  
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ภาพที่  1-40  แสดงการสรางขอมูลเชิงพ้ืนที่รูปทรงเรขาคณิต 
  
 

1.  ขอมูลเชิงพ้ืนที่รูปทรงเรขาคณิต สรางโดยเลือกเคร่ืองมือตามลักษณะรูปทรงที่ตอง
การสราง เชน   (Draw Rectangular) หรือ   (Draw Cycle) บน Toolbar จากน้ัน Click 
Mouse คางไวในตําแหนงเริ่มตนที่ตองการบน View Window และลาก Mouse จนไดขนาดที่ต
องการ ใหปลอย Mouse ก็จะไดขอมูลเชิงพ้ืนที่ในขนาด ตามที่ตองการ   

2.  ขอมูลเชิงพ้ืนที่รูปทรงอิสระ สรางโดยเลือกเคร่ืองมือ   (Draw Polygon) ที่ Tools 
Bar และ Click บน View Window ในตําแหนงที่ตองการ เพ่ือเปนการเริ่มจุดเร่ิมตน จากน้ัน 
Click mouse ตอไปเพ่ือสรางรูปทรงของขอมูลเชิงพ้ืนที่ จนถึงจุดส้ินสุดของรูปทรง ให Double 
Click เพ่ือเปนการสิ้นสุด ดังภาพ  
  

 
 

ภาพที่  1-41  แสดงการสรางขอมูลเชิงพ้ืนที่ลักษณะพืน้ที่รูปทรงอิสระ 
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1.4.18 การจัดการตารางฐานขอมูล  

Table Window เปนอีกองคประกอบหนึ่งของ Project ที่ใชในการแสดงฐานขอมู
ลของแผนที่หรือฐานขอมูลอ่ืน ๆ ที่จะเก็บโดยใช dBase และ ArcView สามารถรับขอมูลจาก
แหลงอ่ืนๆ เชน Microsoft Access แลวนํามาบันทึกไวใน 3 รูปแบบ คือ dBase, INFO (จาก 
Arc/Info) และ Delimited Text   
  

การเปดตารางฐานขอมูล  
การเปดตารางฐานขอมูลของ Theme ทําโดย เลือก Theme น้ันให Active แลว Click 

ที่ ปุม Open theme table   หรือ เลือกที่เมนู Theme แลวเลือก Table ดังภาพที่แสดง  
  

 
  

โดยปกติในแฟมขอมูล Coverage หรือ Theme ที่สรางขึ้นดวยโปรแกรม ArcVeiw หรือ 
Arc/Info จะมีฐานขอมูลที่เปน Spatial data (Graphic) และ Non-spatial data (Attribute) จึง
สามารถนํามาใชงานในการวิเคราะหหรือแสดงผลไดอยางสมบูรณ ซ่ึง Spatial data มักจะ
แสดงอยูบน View window สวน Non-spatial data จะแสดงไวบน Table window ซ่ึงขอมูลทั้ง
สองสวนจะสัมพันธกัน  

ในสวนนี้ ArcView สามารถสรางฐานขอมูล dBase ขึ้นมาได เพ่ือเปนฐานขอมูลเสริม
เพ่ือสรางความสมบูรณของการอธิบาย Code ที่อยูในฐานขอมูลไดละเอียดขึ้น การเปดตาราง
ฐานขอมูลของ Theme ทําโดย เลือก Theme น้ันให Active แลว Click ที่ ปุมOpen theme 

table หรือ เลือกที่เมนู Theme แลวเลือก Table แลวจะไดตารางดังภาพที่แสดง  
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ขอสังเกต  ตารางหลักที่เปดขึ้นมาจาก Theme ที่ Active อยูจะมีชื่อ "Attributes of” 
นําหนาชื่อ Theme น้ันเสมอ (เปนคา default ของโปรแกรม) 
  

 
  

ถาสังเกตโดยสวนใหญ Field ที่นาสนใจมักจะอยูทางขวาของตารางเชน Region ดังที่
เห็นในภาพ อาจจะสามารถนํามาใชในการจัดทํา KeyField ในการเชื่อมโยงระหวางตารางได  

ในการแสดงผลขอมูลแผนที่บางครั้งมีความจําเปนที่จะตองแสดงผลโดยอาศัยขอมูล
เสริม เชน คําอธิบายแผนที่แสดงขอบเขตการปกครองสวนภูมิภาค โดยแสดงเปนชื่อภาษาไทย 
หรืออังกฤษ ดังนั้นจําเปนจะตองจัดหา หรือสรางตารางเสริมขึ้นมาเพื่อเพ่ิมรายละเอียดของ
ขอมูลแผนที่ ใหสามารถอธิบายดวยภาพไดดีขึ้น  
  

การสรางตารางใหม  ในกรณีที่ตองการสรางตารางฐานขอมูลใหมโดยใชโปรแกรม 
ArcView สามารถทําไดดังน้ี   

1)  การคลิกเลือกที่ Table icon ใน Project Window แลว กดปุม New   
2)  ใหเลือกที่จัดเก็บขอมูล (directory) และใหตั้งชื่อแฟมขอมูล (File name) แลวกดปุม 

OK ก็จะปรากฏตารางเปลาที่เตรียมสําหรับกรอกขอมูล  
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เราจะไดตารางเปลาพรอมใชงานในการสรางฐานขอมูลเชิงบรรยาย (Attribute Data) ดังน้ี  

 
  

เม่ือปรากฏตารางเปลาขึ้นมา ขั้นตอไป คือการกรอกขอมูลที่ตองการใสในตารางจะมี
องคประกอบสําคัญในการจัดทํา Data Definition คือ จะตองกําหนด ไดแก *ชื่อของ Field, *
ชนิดของ Field ขอมูล และ *ขนาดของ Field ขอมูล  

3) ใหเลือกเมนู Edit --> Add field ก็จะปรากฏตารางใหกรอกขอมูล Data Definition 
ดังรูปขางลางและใหกรอกรายละเอียด Data definition ใหครบ คือ Region, Number, 1, 0 
Description, String, 53 ไดดังรูป  
 

 

 

 

 

 
       

 
 

  
 

  
ผลลัพธก็จะไดตารางที่ประกอบดวยชื่อ Field สองชุดดังรูป 
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4) เลือกเมนู Edit --> Add Record หรือ Ctrl + A เพ่ือเพ่ิม record ในฐานขอมูล 

สามารถเลือกเมนูซํ้าๆ เพ่ือเพ่ิม record ใน Table ตามจํานวนที่ตองการ ใหเพ่ิม 5 Record แลว
พิมพขอมูลเขาไปดังรายละเอียด 
  

 
 

  
 
 
 
 

โดยฝกฝนการใชเคร่ืองมือสําหรับการกรอกขอมูลตอง click ไปที่ปม  Edit Tool และถาต

องการเลือก record ใดๆ ให click ไปที่ปุม  Select Tool เม่ือเสร็จกระบวนการใหเลือกไปที่
เมนู Table--> Stop Editing ทุกคร้ังที่มีการแกไขเสร็จ  (ถาจะทําการแกไขใหม ใหเลือกที่คําสั่ง 
Table--> Start Editing เพ่ือเริ่มแกไขใหม )   

ขอสังเกต  เราจะเห็นวาตารางที่หยุดการแกไขแลวจะมีชื่อ Field เปนตัวอักษรเอียง 
(Italic) 
  

การ Join Table  
การ Join table ถือเปนการเชื่อมตอขอมูลแบบชั่วคราว ใชในกรณีที่ขอมูลในตารางหนึ่ง 

มีรายละเอียดไมเพียงพอที่จะตอบคําถามที่ตองการได จําเปนตองใชขอมูลในอีกตารางหนึ่ง
มาเปนตัวขยาย ทั้งน้ีทั้ง 2 ตารางจะตองมี field ที่มีคุณสมบัติเดียวกันที่สามารถอางอิงขอมูลถึง
กันได  

ทําไดโดยเปด Table ขึ้นมาทั้งสอง Table ซ่ึงประกอบดวย Table หลัก และ Table 
เสริม โดยที่ Table หลักคือ Table ที่จะคงอยูภายหลังทําการ join ขอมูลแลวเสร็จ  

เม่ือเปด Table มา 2 table แลวให Click ที่ Field Name ของทั้งสอง Table ที่จะทําการ 
Join กัน ให Active แลว Click Table หลักให Active จากน้ันเลือก Join   ที่ Menu Bar 
หรือเลือก Table >> Join หรือ กด Ctrl + J ที่ Keyboard ตามกระบวนการดังภาพ  
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ผลลัพธของการ Join Table จะทําใหไดตารางเดียวที่รวบรวมเอาขอมูลของทั้ง 2 
ตารางมาเก็บไวดวยกัน ดังรูป โดยสามารถยกเลิกการ Join Table ไดโดย Active ที่ Table ที่
ถูก Join อยูแลวเลือกที่ Table >> Remove All Joins ที่ Menu Bar ดังภาพ  
  

การ Link Table  
การ Link table เปนการเช่ือมตอขอมูลแบบชั่วคราวคลายกับการ Join Table เพ่ือ

ขยายใหเห็นรายละเอียดของขอมูลที่มากขึ้น การ Link Table น้ีจะใชกับตารางที่มีความสัมพันธ
กันแบบ one-to-many ทั้งน้ีทั้ง 2 ตารางจะตองมี field ที่มีคุณสมบัติเดียวกันที่สามารถอางอิง
ขอมูลถึงกันได เชนเดียวกับการ Join Table  

ทําไดโดยเปด Table ขึ้นมาทั้งสอง Table (Table หลัก และ Table เสริม) แลวให Click 
เลือก Field Name ที่ใชเชื่อมความสัมพันธของ 2 Table จากน้ันให Click Table หลักให Active 
แลวเลือก Table >> Link  
  
  

 
 

เม่ือทําการ Link Table แลว ตารางทั้ง 2 จะยังคงอยู แตจะแสดงความเชื่อมโยงกัน โดย
เม่ือเลือกขอมูลที่ Table หลัก ขอมูลที่ Link อยูใน Table เสริมก็จะถูกเลือกดวย ดังรูป  
  

 
 

โดยสามารถยกเลิกการ Link Table ไดโดย Active ที่ Table หลักที่ถูก Link อยูแลว
เลือกที่ Table > Remove All Link ที่ Menu Bar ดังภาพ  

การคํานวณคาใน Field ที่กําหนด  
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- Click เลือก field ที่ตองการใสคา หรือสราง field ใหม  

- ที่ Field menu เลือก calculate หรือ เลือก calculate button  
- ใน Field calculator เลือก field ที่ตองการมาคํานวณ ระบุชนิดของขอมูลและเลือก 

requests (สูตรในการคํานวณ)  
- Click OK  

 

 
 

 
ตารางกอนคํานวณ 

  
ตารางหลงัคาํนวณ 

  
 
 คําอธิบายเครื่องหมาย  
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= เทากับ  > มากกวา  
>= มากกวาหรือเทากับ  < นอยกวา  
<= นอยกวาหรือเทากับ  <> ไมใช  (ใชกับตัวเลข)  
not ไมใช (ใชกับตัวอักษร)  and และ  
or หรือ     

 
1.4.19 การสรุปผลขอมูล (Summarize data)  
เปนการสรุปขอมูลในตารางโดยการพิจารณาวามีก่ี Record ที่มีคาใน field ที่พิจารณาท่ี

เหมือนกัน และสามารถนําคาใน field ที่เปนตัวเลขมาคํานวณหาคาสถิติตาง ๆ โดยสรางผลการ
คํานวณเปนตารางใหม  

- ที่ตาราง click field ที่ตองการคํานวณ  

- เลือก summarize button   
- ใน summary table definition  
- ใสชื่อ out put file ที่ไดจากการคํานวณ  
- เลือก field ที่จะคํานวณ  
- เลือกชนิดของ statistic  
- Click add จะได output field  
- Click OK  

 
เชน ตองการทราบจํานวนนักเรียนของโรงเรียนแตละประเภทมีจํานวนเทาไร ใหเลือก 

Field student_type (เปน field ที่เก็บขอมูลประเภทโรงเรียน เชน P = ประถมศึกษา, M = 
มัธยมศึกษา) มาคํานวณ และเลือก summarize button เลือก field student (เปน field ทเก็บข
อมูลจํานวนนักเรียน เลือก sum click add และ OK  
  

  
 
 

ผลที่ไดจากการคํานวณ  
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การจัดรูปแบบตาราง  
1) การเลือกแสดงเฉพาะ field ในตาราง  

- ที่ Table menu เลือก properties  
- Check หรือ uncheck หนา field ที่ตองการ  
- Click OK   

 

2)  
 
 
 
 
 

1)  
 
2) การแกไขชื่อตาราง และชื่อ field  

- Click ชื่อ ตารางในชอง title  
- แกชื่อ Field ในชอง alias column  
- Click OK  

3) การยอ/ขยายขนาดของ field  
- ใช cursor เลื่อนไปที่มุมขวาเพ่ือยอ/ขยายขนาดของ field  

4) การเลือกการเรียงลําดับขอมูล  
- click เลือก field ที่ตองการใหเรียงลําดับ  
- เลือกปุม sort descending (เรียงจากมากไปนอย)   หรือ ascending 

(เรียงจากนอยไปมาก)  
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การแสดงผลขอมูลที่เลือก  

 
 

เปนการแสดงรายละเอียดที่เก็บในตารางฐานขอมูลของขอมูลเชิงพ้ืนที่และเชิงบรรยาย
ที่เลือก ทําไดโดยเลือก Identify   ที่ Tools Bar แลว Click ที่ Records ของ Table หรือ 
click ที่ Feature ใน Theme ที่ตองการซ่ึงจะแสดงรายละเอียดดังภาพ  
 
 

1.4.20 การใชเครื่องมือ Query Builder   
เปนการคนหาขอมูลที่ตองการอยางมีเง่ือนไข ใชคนหาขอมูลไดทั้งขอมูลเชิง

พ้ืนที่และขอมูลเชิงบรรยายในตาราง  ทําไดโดย Active Theme หรือ Table ที่ตองการเรียกค
นขอมูล แลวเลือก Query Builder   ที่ Tools Bar หรือเลือก Theme >> Query… เม่ือตอง
การเรียกคนขอมูลเชิงพ้ืนที่ หรือ Table >> Find… เม่ือตองการเรียกคนขอมูลใน Table หรือ
กดปุม Ctrl + Q ที่ Keyboard  
  

  
 
  

จะปรากฏ Dialog Box (ดังรูป) เพ่ือเลือกเง่ือนไขการเรียกคน โดยตองกําหนดเง่ือนไข
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ในการเรียกคน อันไดแก ชื่อ field, operator และ value เหมือนสมการคณิตศาสตร  โดย
อาจพิมพเง่ือนไขเอง หรือ Double Click เลือกชื่อ Field, เง่ือนไข และ Value ก็ได  ทั้งน้ีมีขอกํา
หนดวา คาของ Value ที่เปนตัวอักษรจะตองอยูภายใต “ ” กํากับ  
 

เงื่อนไขที่ใชในการคนหามีดังน้ี  
  

สัญลักษณ ความหมาย สัญลักษณ ความหมาย สัญลักษณ ความหมาย 

= เทากับ <> ไมเทากับ and และ 
> มากกวา >= มากกวา 

หรือเทากับ 
or หรือ 

< นอยกวา <= นอยกวา 
หรือเทากับ 

not ไมใช 

 
รูปแบบการเลือกจะมี 3 แบบ คือ  

- New Set เลือกตามเง่ือนไขใหม  
- Add to Set เพ่ิมขอมูลจากที่เลือกไวแลว  
- Select From Set เลือกจากกลุมขอมูลที่เลือกไวแลว  
หลังจากเลือกตามเง่ือนไขแลวผลที่ได จะปรากฏเปนสีเหลืองบน Theme และ Records 

ภายใน Table ที่เลือก  
 

 
เครื่องมือ Select By Theme  
ใชคนหาขอมูลไดทั้งขอมูลเชิงพ้ืนที่ ทําไดโดยให Active Theme ที่ตองการเรียกคน แลว

เลือก Theme >> Select by Theme จะปรากฏ Dialog Box ใหกําหนดเง่ือนไข และเลือก 
Theme ที่ใชในการกําหนดขอบเขต ดังน้ี  

- Intersect เลือกพ้ืนที่ทีซอนทับ (ซอนทับทั้งหมดหรือบางสวน) กับพ้ืนที่ที่ถูกเลือกไว  
- Are completely within พ้ืนที่ทั้งหมดอยูภายใน Selected Features  
- Completely Contain พ้ืนที่ที่ครอบคลุม Selected Features ทั้งหมด  
- Have their Center In พ้ืนที่ที่มีจุดก่ึงกลางของขอมูลอยูใน Selected Features  
- Contain the Center of พ้ืนที่ที่ครอบคลุมจุดก่ึงกลางของ Selected Features  
- Are Within Distance of  พ้ืนที่ที่อยูในรัศมี (เมตร) จาก Selected Features  
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หลังจากเรียกคนตามเงื่อนไขที่กําหนดแลว หากมีขอมูลที่ตรงกับเง่ือนไขที่เรียกคน ผล

ที่ได จะปรากฏเปนสีเหลืองบน Theme และ Records ภายใน Table ที่เลือก  
  

1.4.21 การจัดเก็บขอมูลที่ตองการ  
เม่ือเลือกขอมูลภูมิสารสนเทศที่ตองการไดแลว หากตองการจัดเก็บเปน 

Theme ใหม สามารถใช Convert to Shapefile เพ่ือสราง Theme ใหม ทําไดโดยเลือก Theme 
หรือ Feature ที่ตองการสรางเปน Theme ใหม แลว Active Theme น้ันไว จากนั้นเลือกที่ 
Theme >> Convert to Shape file จะปรากฎ Dialog Box ใหตั้งชื่อ File และเลือก Directories 
ที่จัดเก็บใหเลือก OK ซ่ึงผลที่ไดจะเปน Theme ใหมที่มีเฉพาะขอมูล Feature และ Table ที่
เลือกไว  
 

 
 

 

1.4.22 การวิเคราะหขอมูลเชิงพื้นที่โดยใช Extensions Geoprocessing  
สําหรับการวิเคราะหขอมูลเชิงพ้ืนที่ดวย ArcView GIS 3.x จําเปนตองเรียกใช

งาน Extension ที่ชื่อวา Geoprocessing โดยเลือกที่ File >> Extensions แลวเลือกที่ 
Geoprocessing และเลือก OK เพ่ือเปดการทํางานของ Extensions Geoprocessing ดังภาพ  
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จากน้ันเม่ือเราตองการวิเคราะหขอมูลเชิงพ้ืนที่ ใหเขาไปในเมนู View >> 
Geoprocessing Wizard ดังภาพ (กอนการใชงาน Geoprocessing Wizard จะตองเปด 
Theme ที่ตองการวิเคราะหไวใน View Window กอน) จะปรากฏ Dialog Box ของ 
Geoprocessing ขึ้นมา ซ่ึงมีชุดคําสั่งตางๆ ใหเลือกใชงานแตละชุดคําส่ังมีการทํางาน ประกอ
บดวย Dissolve, Merge, Clip, Intersect, Union และ Assign  

 
Dissolve: การรวม Attribute data ที่เหมือนกัน  
เปนการรวม Attribute data ที่เหมือนกันใหเปนขอมูลเดียวกัน โดยสามารถ

เลือกรวมขอมูลไดตาม Field ที่ตองการ โดยการใชงานสามารถทําไดดังน้ี   
หลังจากเลือก Dissolve features base on an attribute จาก Geoprocessing 

Wizard แลวเลือก Next จะมี Dialog Box ใหเลือก Theme และ Attribute ที่ตองการ Dissolve 
และใหเลือกตั้งชื่อ Output file และ Directories ที่ตองการจัดเก็บ แลวเลือก Next  
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จะมี Dialog Box ใหเลือก Field ที่ตองการใน Output file ซ่ึงจะเลือกหรือไมก็ได แล
วเลือก Finish เปนการสิ้นสุดขั้นตอนการ Dissolve โดยลักษณะของผลการ Dissolve จะเปนดัง
รูป  

Merge: การตอขอมูลตั้งแต 2 Theme ข้ึนไป 
Merge จะเปนการตอขอมูลประเภทเดียวกันตั้งแต 2 Theme ขึ้นไป โดยในการใชงาน

สามารถทําไดดังน้ี  
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หลังจากเลือก Merge Themes Together จาก Geoprocessing Wizard แลวเลือก 
Next จะมี Dialog Box ใหเลือก Themes ที่ตองการ Merge และ Theme ที่ใชเปน Attribute 
หลัก และใหเลือกตั้งชื่อ Output file และ Directories ที่ตองการจัดเก็บ แลวเลือก Finish เป
นการสิ้นสุดขั้นตอนการ Merge โดยผลการ Merge จะเปนดังรูป  
  

 
  

Clip: การตัด Theme ใหอยูในขอบเขตที่ตองการ โดยใช Theme ที่เปน Polygon  
เปนขอบเขต 
 

Clip จะเปนการตัด Theme ใหอยูในขอบเขตที่ตองการ โดยใช Theme ที่เปน Polygon 
เปนขอบเขต โดยในการใชงานสามารถทําไดดังน้ี  

หลังจากเลือก Clip one theme based on another จาก Geoprocessing Wizard แล
วเลือก Next จะมี Dialog Box ใหเลือก Themes ที่ตองการ Clip และ Theme ที่ใชเปนขอบเขต 
และใหเลือกตั้งชื่อ Output file และ Directories ที่ตองการจัดเก็บ แลวเลือก Finish เปนการสิ้น
สุดขั้นตอนการ Clip โดยลักษณะของผลการ Clip จะเปนดังรูป  
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Intersect: เปนการตัดขอมูล 2 Theme ที่ซอนทับกันออกมาเปน Theme ใหม 
Intersect จะเปนการตัดขอมูล 2 Theme ที่ซอนทับกันออกมาเปน Theme ใหม โดยในการใช
งานสามารถทําไดดังน้ี  

หลังจากเลือก Intersect two themes จาก Geoprocessing Wizard แลวเลือก Next จะ
มี Dialog Box ใหเลือก Themes ที่ตองการ Intersect กันทั้ง 2 Theme และใหเลือกตั้งชื่อ 
Output file และ Directories ที่ตองการจัดเก็บ แลวเลือก Finish เปนการสิ้นสุดขั้นตอนการ 
Intersect โดยลักษณะของผลการ Intersect จะเปนดังรูป  
  

  
 

Union: การรวมขอมูล 2 Theme เขาดวยกันเปน Theme ใหม  
Union จะเปนการรวมขอมูล 2 Theme เขาดวยกันเปน Theme ใหม โดยในการใชงาน

สามารถทําไดดังน้ี  
หลังจากเลือก Union two themes จาก Geoprocessing Wizard แลวเลือก Next จะมี 

Dialog Box ใหเลือก Themes ที่ตองการ Union กันทั้ง 2 Theme และใหเลือกตั้งชื่อ Output 
file และ Directories ที่ตองการจัดเก็บ แลวเลือก Finish เปนการสิ้นสุดขั้นตอนการ Union โดย
ลักษณะของผลการ Union จะเปนดังรูป  
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Assign Data by Location: การนําเฉพาะ Attribute Data มาเชื่อมตอกันระหวาง 
Theme  

Assign Data by Location เปนการนําเฉพาะ Attribute Data มาเชื่อมตอกันระหวาง 
Theme โดยจะเชื่อมตอเฉพาะขอมูลที่อยูในพ้ืนที่เดียวกัน โดยในการใชงานสามารถทําไดดังน้ี  

หลังจากเลือก Assign Data by Location จาก Geoprocessing Wizard แลวเลือก 
Next จะมี Dialog Box ใหเลือก Themes หลักที่ตองการนําขอมูลมาเชื่อมตอ และเลือก Theme 
ที่จะนําขอมูลมาเชื่อมตอ แลวเลือก Finish เปนการสิ้นสุดขั้นตอนการ Assign Data by 
Location โดยลักษณะของผลการ Assign Data by Location จะเปนดังรูป  
 

  
การสรางแนวกันชน (Create Buffers)  
Buffers เปรียบเสมือนแนวกันชนที่อยูโดยรอบวัตถุเชิงพ้ืนที่ การสราง Buffer ไมจําเป

นตองใช Extension ใด เน่ืองจากโปรแกรม ArcView3.x มีความสามารถนี้อยูแลว เพียงแตตอง
กําหนดหนวยวัดของแผนที่ในแตละ View ใหเรียบรอยเสียกอน โดยเขาไปที่ View >> 
Properties… จากน้ันใหกําหนด Map Units: และ Distance Units: กอน  
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วิธีการสราง Buffer ทําไดโดยเลือก Theme >> Create Buffers…ตอมาจะมี Dialog 
Box ใหเลือกแหลงขอมูลที่ตองการสราง Buffers อันประกอบดวย การสรางจาก Graphics หรือ
จาก Features ใน Theme โดยตองกําหนด theme ที่ตองการสราง เม่ือกําหนดตามที่ตองการ
แลวใหเลือก Next  

จะปรากฏ Dialog Box ใหเลือกรูปแบบการสราง Buffers และ Distance unit ซ่ึงมี
คําอธิบายเปนรูปอยูดานขาง เม่ือเลือกไดแลว ใหเลือก Next  
 

  
 
  
จากน้ันจะมี Dialog Box ใหเลือกรูปแบบของ Output แลวเลือก Finish เปนการสิ้นสุดขั้นตอน
การ Create Buffers (Create buffer so they are จะมีเฉพาะขอมูลที่เปน Polygon)  
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1.4.23 วิธีการสรางแผนภูมิ   
เปนการนําเสนอขอมูลในตารางฐานขอมูล ทั้งที่เปนตารางที่ติดมากับขอมูลพ้ืน

ที่ (Attribute table) หรือ ตารางฐานขอมูลอ่ืน (Table.dbf) ซ่ึงมีความสัมพันธกับขอมูลเชิงพ้ืนที่ 
ทั้งนี้ขอมูลที่นําเสนอ โดยใชแผนภูมิอาจใหความกระจางมากกวา ขอมูลที่นําเสนอในรูปตาราง 
หรือแผนที่ (ในบางกรณีดูยาก) แตในการสรางแผนภูมิดวย ArcView เองบางครั้งก็ยังมีขอจํา
กัดอยูเชนกัน ดังน้ันเราสามารถที่จะประยุกตใชจากโปรแกรมประยุกตอ่ืนๆ ที่สามารถสราง 
Graph ไดสวยงามกวา โดยดึงฐานขอมูลจาก ArcView ไปทํางานได เชน Microsoft Excel แลว
เปลี่ยน Graph ใหอยูในรูปแบบ Graphic ได  
  

  
 
   1) เปดตารางฐานขอมูลที่ตองการสรางแผนภูมิ   

   2) ใหเลือกเมนู Table--> Chart หรือกดที่ปุม  Create Chart button  
   3) ใหเลือก Field (ตัวเลข) ที่ตองการแสดงในรูปแบบกราฟแลวกดปุม Add   
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   4) ถาตองการใสขอความอธิบายซึ่งอาจเปนตัวเลขหรือตัวอักษร ใหเลือก Field น้ันใน
ชอง Labeling series using ถาหากกําหนดคุณสมบัติตางๆ เรียบรอยแลว สามารถตั้งชื่อ
แผนภูมิไดในชอง Name และไดแผนภูมิผลลัพธออกมาผลลัพธที่ไดรับจะเปนดังรูป  

 

         
   5) ถาตองการเปลี่ยนแปลงประเภทของกราฟ ใหเลือกประเภทของแผนภูมิไดจากปุม
เหลาน้ี 
 

 
  
  
  
  
  
  
  



โครงการฝกอบรม  
โปรแกรม PC Arcview ในการจัดทําฐานขอมูล GIS 
 

 
  

56 

 
  

6) ในกรณีที่ตองการเปลี่ยนตําแหนงสัญลักษณ หรือคําอธิบายขอความในแผนภูมิ หรือ
คําอธิบายในแกน x-y และอ่ืนๆ ใหกดเครื่องหมาย Chart Element Properties แลวกดไปท่ี

รายละเอียดในแผนภูมิที่ตองการแกไข เชน ถาตองการใสชื่อกราฟ ใหกดที่ปุม  (Chart 
Element Properties) แลวใหไป Click ที่คําวา Title แลวตั้งชื่อใหม   

7) ในกรณีที่ตองการเปลี่ยนสีของแผนภูมิ ใหกดไปที่เคร่ืองแปรงทาสี  chart color 
เลือกสีที่ตองการแลวนําไปกดที่แผนภูมิที่ตองการเปลี่ยนสี  
 

 
 

1.4.24 การสราง Layout จาก Project Window  
ใหเปด View ขึ้นมา (1 View หรือมากกวาก็ได) โดยใน View ที่เปดขึ้นมาให

นําขอมูลตาง ๆ ที่ตองการใชใน Layout เขามาใน View โดยตกแตงขอมูลตาง ๆ บน View 
Window ตามรูปแบบที่ตองการใหไปปรากฎบน Layout รวมทั้งกําหนด Map Unit และ 
Distance Unit ที่ View Properties กอน จากน้ันใหไปที่ Project Window > Layout > New ซ่ึง
จะได Layout วาง ๆ ขึ้นมา ดังภาพ  
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โดย Layout ที่สรางขึ้นมาสามารถกําหนดรูปแบบ หรือขนาดของกระดาษ ไดโดยเลือก
ที่ Layout > Page Setup ที่ Menu Bar ดังภาพ  
  

 
  

หรือจะใช Template ที่มีอยูแลวก็สามารถทําไดโดยเลือกที่ Layout > Use Template…
ที่ Menu Bar ดังภาพ  
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ตอมาจะเปนการใสองคประกอบตางๆ ลงไปใน Layout โดยเครื่องมือที่ใชในการสราง 
Layout จะปรากฏขึ้นมาบน Tools Bar โดยเคร่ืองมือตางๆ มีดังน้ี  
  

  View Frame    Legend Frame   Scale Bar   North Arrow 
  Chart Frame    Table Frame    Picture Frame 

  
ซ่ึงในการใชงานสามารถใชไดโดยเลือกเคร่ืองมือที่ตองการที่ Menu Bar แลวนําไปลาก

จากมุมหน่ึงไปอีกมุมหน่ึงบน Layout ในขนาดที่ตองการ โดยจะขอกลาวถึงเครื่องมือตางๆ 
เพียงบางสวนที่จําเปนตอการใชงานดังน้ี  

1) View Frame    
เม่ือนํา View Frame เขามาใน Layout จะมี Dialog Box ใหกําหนดคาตาง ๆ 

โดยสามารถกําหนดไดตามตองการ โดยสามารถเลือกไดจาก View ที่มีอยู โดยหากตองการ
กําหนดมาตราสวนใหเปนขนาดที่ตองการใหเลือกที่ Scale เปน User Specified Scale แลวกํา
หนดตัวเลขตามตองการ สวน Live Link หากถูกเลือกไวจะทําใหหากมีการเปลี่ยนแปลงใด ๆ 
ใน View ในสวนของ Layout ก็จะถูกเปลี่ยนแปลงตามไปดวย  
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2) Legend Frame    
เม่ือนํา Legend Frame เขามาใน Layout จะมี Dialog Box ใหกําหนดคาตางๆ 

โดยสามารถกําหนดไดตามตองการ โดยสามารถเลือกไดจาก View ที่มีอยู  
  

 
  
 

 

 

3) Scale Bar     
เม่ือนํา Scale Bar เขามาใน Layout จะมี Dialog Box ใหกําหนดคาตางๆ โดย

สามารถกําหนดไดตามตองการ โดยสามารถเลือกไดจาก View ที่มีอยู  
  

 
 

 

 

4) North Arrow     
เม่ือนํา North Arrow เขามาใน Layout จะมี Dialog Box ใหกําหนดคาตางๆ 

โดยสามารถกําหนดไดตามตองการ  
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5) Picture Frame    
เม่ือนํา Picture Frame เขามาใน Layout จะมี Dialog Box ใหเลือกรูปภาพที่

มีอยูในเครื่องคอมพิวเตอร โดยเลือก Browse เพ่ือไปยัง Directories ที่จัดเก็บภาพที่ตองการ  
  

 
  
 

6) Neatline     
Neatline จะเปนเสนที่ใชลอมรอบ Features หรือแผนที่ ซ่ึงการใชงานสามารถ

ทําไดโดยเลือก Layout > Add Neatline... ที่ Menu Bar หรือเลือกที่   Neatline ที่ Tools 
Bar ซ่ึงจะมี Dialog Box ใหกําหนดคาตางตามตองการ ดังภาพ  
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7) Text  
การเพ่ิม Featuresที่เปนขอความเขาไปใน Layout สามารถทําไดโดยการเลือก

เคร่ืองมือ Text ที่ Tools Bar ซ่ึงจะมี Text ในรูปแบบตางๆ ใหเลือกใช ใหเลือกรูปแบบที่ตอง
การแลวนําไป Click ในตําแหนงที่ตองการบน Layout ซ่ึงจะมี Dialog Box ใหใสขอความที่ตอง
การลงไป ดังภาพ  

 
 

8) Graphics  
Graphics รูปแบบตางๆ ที่สามารถนําไปใสใน Layout ไดซ่ึงจะอยูที่ Tools Bar เชนกัน  
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1.4.25 การสราง Layout จาก View Window  
สามารถทําไดโดยตกแตงขอมูลตาง ๆ บน View Window ตามรูปแบบที่ตอง

การใหไปปรากฏบน Layout รวมทั้งกําหนด Map Unit และ Distance Unit ที่ View Properties 
กอน จากน้ันเลือกที่ View > Layout… ซ่ึงจะมี Template ของ Layout ใหเลือก แลวเลือก OK  
  

 
  

โดยจะไดผลดังภาพ ซ่ึงจะเหมือนกับที่ปรากฏบน View Window 
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ซ่ึงวิธีน้ีจะรวดเร็วกวาการการสราง Layout จาก Project Window การสราง Layout 
จาก Project Window ซ่ึงเพียงปรับแตงการจัดวางองคประกอบตาง ๆ บน Layout ก็จะสามารถ
ใชงานได โดยวิธีการปรับแตงเหมือนกันกับการสราง Layout จาก Project Window 
 
 

 
 
 


